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| Read This First

B Disclaimer

* While every effort has been made to ensure that the information contained in
this guide is accurate and complete, no liability can be accepted for any
errors or omissions. Canon reserves the right to change the specifications of
the hardware and software described herein at any time without prior notice.

* No part of this guide may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form, by any means,
without the prior written permission of Canon.

» Canon makes no warranties for damages resulting from corrupted or lost
data due to mistaken operation or malfunction of the camcorder, the
software, memory cards (miniSD Cards), personal computers, or peripheral
devices, or due to use of a memory card not initialized by a Canon
camcorder.

B Trademark Acknowledgments

* QuickTime is a trademark of Apple Computer, Inc.

« Microsoft® and Windows® are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

* miniSD is a trademark of SD Card Association.

* Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.

© Canon Inc. 2006 All rights reserved.

B Safety Precautions

Do not play the supplied CD-ROM(s) in any CD player that does not support
data CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player)
could damage the speakers. It is also possible to suffer from hearing loss from
listening with headphones to the loud sounds of a CD-ROM played on a music
CD player.

Checking Supplied Accessories

Use the following accessories to download recorded images from a memory card
to your computer.

* IFC-300PCU USB Cable * DIGITAL VIDEO SOLUTION DISK

The explanations in this manual use mainly Windows XP screen shots. The
steps and windows may vary depending on your computer and the version of
software.
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| System Requirements

Please install the software on a computer meeting the following minimum
requirements.

[E]

OS: Windows 98 (Second Edition)
Windows Me
Windows 2000 (Service Pack 4)
Windows XP Home Edition or Professional
(Service Pack 1 or 2)
* Proper operation is not guaranteed on an OS that has
been upgraded from a previous version.

Computer Model: Computers that come with above OS preinstalled and
have built-in USB ports.

CPU: Pentium 500 MHz or better

RAM: Windows 98/Windows Me: 128 MB or more
Windows 2000/Windows XP: 256 MB or more

Interface: USB: only preinstalled Windows 98/Windows Me/Windows

2000/Windows XP systems with built-in USB ports

Free Hard Disk Space: -+ Canon Utilities
- ZoomBrowser EX: 250 MB or more (Including the
PhotoRecord printing program)
- PhotoStitch: 40 MB or more
« Canon DV TWAIN Driver: 25 MB or more
« Canon DV WIA Driver: 25 MB or more

Display: 1024 x 768 pixels or better/High Color (16 bit) or better

@ O Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.
\&¥] o Proper operation is not guaranteed on any particular system, even if it meets
the requirements outlined above.
o A CD-ROM drive is required to install the software.

In this Instruction Manual, product names are abbreviated as follows:

Microsoft® Windows® 98 Second Edition: Windows 98
Microsoft® Windows® Millennium Edition: Windows Me
Microsoft® Windows® 2000 (Service Pack 4): Windows 2000
Microsoft® Windows® XP Home Edition or Professional

(Service Pack 1 or 2): Windows XP

System Requirements I 5



| What is Digital Video Software?

The following software will be installed by installing the Digital Video Software.

B ZoomBrowser EX

* Viewing downloaded still images

» Categorizing, organizing, and searching large volumes of still images
« Editing still images

* Changing the data for still images and save them as new files

* Viewing still images in a slide show

* Adding sound to a still image

B CameraWindow

* Downloading still images from a disc or a memory card to your computer

* Viewing still images recorded on a disc or a memory card

* Printing still images recorded on the disc or memory card without
downloading the still images to the computer

B PhotoStitch

Merging a series of overlapping still images into a single, seamless panorama

B PhotoRecord

* Printing still images with background, frame, title and comments
» Creating still image albums

B USB Driver

* Driver software that enables you to download images from a memory card to
a computer. Users of Windows XP do not need to install this driver software.
An OS standard driver will be installed automatically.

* Windows 98/Windows 2000: Canon DV TWAIN Driver

* Windows Me: Canon DV WIA Driver

This instruction manual explains how to install the software, what you can do

with the main features and how to operate them. For more detailed operational
instructions, refer to the Help menu of each software program.
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| Windows

CameraWindow

CameraWindow is a program created to download still images from the disc or

memory card to the computer. Furthermore, you can print still images recorded
on the disc or memory card without having the images downloaded to the
computer ([J]40), and you can confirm and change the owner name of the
camcorder you specify ([1]93). Refer to Starting CameraWindow ([] 28) for
launching the software. The Remote capture function is not supported by the

camcorder.

B [Acquire Images] Tab

This tab is used for downloading still images recorded on the disc or memory
card by connecting a camcorder or a card reader/writer to the computer.

Camera Control window

Selects a function in the Camera ——
Control window.

Images will be downloaded to
the computer, and ZoomBrowser EX
starts.

Images in the camcorder are
displayed allowing you to select
images.

Placing a check mark here makes ——
the Camera Control window to open

o A

ﬂ CameraWindow - Canon F43

{ Acquire Images Iﬂrr_!'-Set to Camera Eelc-te shooting)

Downloads using camera

N -
&N Press the camera's button

—"/] Dlizplays this screen when the camera is connected

Preferences...

automatically the next time you

connect the camcorder.

Specify the image type to be downloaded and
the destination folder.
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W [Print] Tab

This tab is used for printing still images on the disc or memory card without
having the images downloaded to the computer. The window varies depending

on the selected printing type. Refer to Printing Still Inages Recorded on the Disc or
Memory Card ([1]40).

Camera Control window

& CameraWindow - Canon k4% %

Prlnts a” Stl” Images In the d|SC or = Acquirelmages|-PfiNt | Setto Camera | Remate shooting;
card one Image per page. [ ]

. A . . daall Print All Photos
Prints all still images in the disc or —

card as an index page (rows of

images on one page). ==
9 page) “‘5?," Print Contact Sheet with All Photos
-

Prints according to the DPOF print ——— ™ | Printaccording to DPOF settings
settings set by the camcorder to the -
still images recorded on the card. ‘—;7

=i

=% Select an image and print

Displays a list of the still images —
in the disc or card, allowing you
to select which ones to print.

Digplays this screen when the camera iz connected

Prefaiences. . Firizh

Unable to set the DPOF print settings to the still images recorded on the disc.

=)
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B [Set to Camera] Tab

This tab is used for confirming and changing the owner name of the camcorder
you can specify ([1]93) and uploading the still images to the card. My Camera

function is not supported by the camcorder.
& CameraWindow - Canon 4 Ao ok _ : ﬂ

| &cquire Images | Print | Setto Camera-l Remote shooting |
Camera Control window
= Set My Camera
Enter or change the name of _lf_%ju‘ Confirmsfchanges camera settings
the camcorder’s owner. 4
. . | =) :
Uploading the images from the —_;,@_-I Uploads images to the camera
computer
Displays thiz screen when the camera iz connected
2Py Selecting [Manage My Camera] from the [Edit] menu displays the [My Camera]

<4 window. If you click [Creating My Camera data] in the [My Camera] window,
[My Camera Maker] will be launched. [My Camera Maker] is a program that
enables you to create and import My Camera contents (Start-up images, Start-
up sound, Shutter sound, Operation sound and Self timer sound) to
camcorders that support this function. Your camcorder does not support the My
Camera function.
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B Camera Browser Window

@ CameraWindow - Ca |m

FilefF) Edit{E) Wiewi) HjpiH)

5 [
[s%a Print = @ Stark ZoomBrowser EX

'Qm’ Image Download

Seact - =

A

Prints the selected still images.

Starts ZoomBrowser EX.

Selects the still image selection method.

Changes the size of the thumbnail.

— | — HE

# | File Information:

File Mame:  IMG_0101JFG
- Modiied: 20001151 4:49:21
=23 )

File Size: S0 KR

Image Size;  B40x480

# | Histogram:

IMG_0101JPG IMG_0102.JPG IMG_0103.PG IMG_0104.PG
j\‘_J Detailz
Ttem Mame Walug A
File Marne IMG_010
= Camera Model M., Canon
Shoating Date(Ti... 1/15/200
Shoating Mode Portrait
Phioto Effect Off
Tv (Shutter Speed) 1740
Ay (Aperture Yal... 2.0
Light Metering Evaluatiy
Exposure Comp,.. O
150 Speed Auto B
l Lens 2.6-65,1
‘ Focal Length 7.9 mm
Digital Zoom Mone
& Image Size 640480
A Image Quality Fine ~
\lan Y

Selects imag| 1 of 4

Selects whether to show or hide the image
frame and file name.

Still image information and a histogram
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Main Window

ZoomBrowser EX is a software program used for organizing, printing and editing the

downloaded still images. If you wish to start ZoomBrowser EX without connecting
the camcorder or card reader/writer, double-click the

on the desktop, or click

ZoomBrowser
EX

the Windows [start] menu and select [All Programs] » [Canon Utilities] »

[ZoomBrowser EX] and [ZoomBrowser EX]. To exit ZoomBrowser EX, click or

select [Exit] from the [File] menu.

#7 ZoomBrowser, EX - C:\Documents and SettingsiCanoniy Documents g@@
Fi n
- = =
Tasks @ ﬂg View Image Properties [l Slide Show “Q Search ﬁ Delete -Eél Rokate ]
@ hequire & Camera Setting rZoomMode Scroll Mode PlewewMode" - — 5
- My Diocument s € t [BH-0- [k ® Show | Alllmagss .,J
1 = L i
] |7 iew & Classfy
3} 200%_01_15 by Music
Edit
B e 4
@‘ Prirt
# I t
x e ) [ ma_o10z.0PG
( Favoite Folders | 4l Felders ) *os o ‘%‘
E 0 :
=3 oo : “
2 PR = (L) My Documents »
(3] 200%_01_15 < IMG_0108.PG  IMG_01
() My Music
% My Pichures
& My Computer My Fictures
3! Search Results
[ £dd to Favorites ] ‘
Selected Ttems: 1

[Acquire & Camera Settings]:

[View & Classify]:
[Edit]:
[Export]:

[Print]:
[Internet]:

Use this to display the Camera Control window to
download still images, to print still images without
having them downloaded to the computer and to
configure the camcorder settings.

Use this to view and organize still images.
Use this to edit still images.

Use this to change the data for still images and
save them as new files, extract still images from
movies, back up to CD-R/RW (Windows XP only),
or export shooting properties to a text file.

Use this to print downloaded still images.

Use this to attach selected still images to E-mail
messages.
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2 Folders Area

You can select a folder to be displayed in the Browser Area. ‘E'l indicates that
newly downloaded still images are in the folder.

Selecting the [Favorite Folders] tab shows only the folders that are registered
as Favorites. To register folders as Favorites, follow the instructions below.

When the [All Folders] tab is selected:
Select a folder and click [Add to Favorites].

When the [Favorite Folders] tab is selected:
Click [Add] and select a folder.

To remove the registered folder, select the folder, and click [Remove].

3 Browser Area

This area displays the images contained in the selected folder. If you place
the cursor over a thumbnail in the browser area, will be displayed at the
upper right corner. Clicking skips over folders to zoom in directly on the
intended folder.

2Py © Qlicking on 2 images while holding down the [Shift] key selects also all
& images between the 2 images.
o Clicking on different images while holding down the [Ctrl] key selects multiple
images.
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4 Browser Area Tool Bar
The menu items vary depending on the View Mode.

1 2 3 4 5 6 7 8

S v |
€ e BH-0-|®R Q | O | | Show | Alimages v

1 | Previous/Next Displays the previous/next image in the current folder.

2 |Up Displays the folder in the upper tiers of the hierarchy.

3 | Select Allows you to select all images and deselects images.

4 | Information Allows you to select the information to be shown. You can
also hide the pop-up window by clearing the checkmark.
The pop-up window appears when you move the mouse
over a thumbnail.

5 | Pan Changes the area displayed when you zoom in on a folder

or image in the Browser Area and drags the thumbnail list.

6 | Restore Display | Changes the size of the thumbnail list to fit the window.

Size
Zoom Slider Enlarges/Reduces the thumbnails in the Browser Area.
Show Allows you to select displayed images according to the

star rating.

Windows I 13



5 View Mode

You can select the view mode of images in the Browser Area.
[Zoom Mode]: The images in the selected folder are shown as thumbnails.

Zoom Made | Scroll Mode | Preview Mode|

MoDren € > 2 |[-0- \1\@1 = Show | #llmages 2

4] 200%_01_15 My Music

IMG_0102.0PG  [MG_0104.0PG

[Scroll Mode]: Thumbnails of the images are displayed next to the folder name.
Clicking a folder displays enlarged images. Selecting [Preferences] from the
[Tools] menu opens the [Preferences] window, on which you can select the
hierarchy of folders.

Zoom Mode | ScrollMode | Preview Mode

€ > 2 [H-0-| [ | show | Allmages v

My Documents

2 s (BES B o
‘ _} My Music (o images) o=, 000,005
‘ j My Pictures o images) J o200

[Preview Mode]: A large image is displayed along with detailed information. You
can change file name and comments. To display another image, click [Previous]/
[Next] or select an image shown at the bottom of the window.

J__Znum Mods | Soroll Mode | Preview Mode

200%_01_15 + A - @+ show | Allmages =
[£] Fils Information: -
FieName:  [IMG_0101
Modiied 1/15/200%
File Size. 828K8

Image Size: 640 % 480
DataType:  JFG
Sound:

[ 2] Star Rating:
" PRSI [] Pratect
[&] Comment:

[E] Keywords
View/Modiy Keywords

[A] Brightness Histogram:

C el b

[AOMWEE  IMG_0102.0PG  IMG_OI03.0PG  IMG_0104.0PG
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6 Application Tool Bar

2 3 4 5 6

Properties @Slide Shaow @ Search % Delete @J Fotate

1 | View Image Displays a selected image in the [Image Viewer] window.

2 | Properties Displays properties of the selected still image. When you
select a different image while the [Properties] window is
open, the information switches to the one of the selected
image. The [Properties] window cannot be displayed in
[Preview Mode].

T Properties
Modifid 14157200
File Size: B2BKB
/ Image Size: E40 = 480
,i Data Type: JPG
Sound:
Pathi  C\Documerts and Setings\Cananihdy Docu
&) File Nam
IMG_0101
2] Star Rating:
[ Protect
[%] Comment
] Keywords
WiewModity Keywards ...

[%] Brightress Histogram:

=

E

(] Shooling Information

Item Name Value ~
File Mame 1MG_0101.JPG
‘amera Model Name  Canon sorsonk
Shooting Date/Time  1/15/2002-4% 25 PM
Shooting Hodz Partrai
Phato Effect 0ff
Tu (Shutter Speed) 1740
b [dnerhine Yah el 2n

ke

|

Slide Show Displays still images in a slide show.

Search Allows you to search for images ([ 1] 57).

Delete Deletes selected images.

o|lal b~ W

Rotate Rotates selected still images. A movie cannot be rotated.
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[Image Viewer] Window

The [Image Viewer] window appears when you select an image and click [View
Image] or double-click an image.

1

Zoom Ratio: 100%

o b om0
File W Hely

=0k

2 34 5 67 8 9

e e

B8 (o 1] (T 1T ) (5] snctvonize

Bl ms_nionps

M & e -

Previous/Next

Displays the previous/next image in the current folder.

Zoom In/Zoom Out

Enlarges/decreases a still image.

3 |Pan When the image is larger than the window, you can move
the image in the desired direction.

4 | Print Prints the selected still image. Refer to [One Photo per
Page Print] ([ 45).

5 | Edit Allows you to perform the following operations: red-eye
correction, auto correct, color and brightness correction,
sharpness adjustment, trimming, inserting texts or
registering external image editing applications.

6 | Auto Focus Frame | This function cannot be used for the images recorded by
the camcorder.

7 | Shooting The shooting information of the image will be displayed.

Information
Show Allows you to display multiple images at the same time.

Synchronize

Synchronizes the View functions across all displayed
images.

10 | Fit to Window Matches the image size to the size of the Image Viewer
Window.
11 | Restore Restores the standard display size.
12 | Zoom Slider Allows you to enlarge/decrease the displayed image.
16 I Windows




13 | Show Image Full Displays an image in full screen size.
Screen

14 | Change the Star Allows you to change the star rating.

Rating
15 | Capturing Frames | Extracts still images from movies. (Windows XP only)

B [Red Eye Correction] Window

Selecting [Red Eye Correction] from the [Edit] menu or the &= jcon allows
you to correct the red eye effect on a still image in the [Red Eye Correction]
window.

[=l Red Eye Correction - C:\Documents and SettingsiCanoniMy Documentsi200X_01_153MG_... |Z\@@

Fied Eye Comrection:

) Auto Mode 1

Stark

) Manual Mode 2

[[] Show Original Image

Lo J s ]

Auto Mode Clicking [Start] corrects the red eye effect automatically.

2 | Manual Mode Point the cursor on a red eye so that the area is
highlighted green, and left-click the mouse.

Windows I 17



B [Auto Adjustment] Window

Selecting [Auto Adjustment] from the [Edit] menu, or clicking the B - jcon
and selecting [Auto Adjustment] allows you to automatically correct the color
balance of the still image.

Auto Adjustment - C:\Documents and SettingsiCanoniy Documentsi200X_01_15MMG_01...

B

Auto Adjust Image

Show Original Image

@ Q|2 o

B [Color/Brightness Adjustment] Window

Selecting [Color/Brightness Adjustment] from the [Edit] menu, or clicking the

Eest - jcon and selecting [Color/Brightness Adjustment] allows you to adjust
the brightness, saturation, contrast, intensity levels, tone curve and RGB of
the still image.

Color/Brightness Adjustment - C:¥Documents and SettingsiCanonkdy Documentsi200X_01... ‘:,IEHXl

Please select adjustment option:

‘ Colar Adjustment

|

Brightness: 7J7

~ Saluration —J =

°_&

Contrast: —J
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B [Sharpness] Window

Selecting [Sharpness] from the [Edit] menu, or clicking the &=t - jcon and
selecting [Sharpness] allows you to emphasize and clarify the outlines of
people and objects.

Sharpness - C:\Documents and SettingsiCanoniy Documentsi200X_01_155MG_0104..JPG \:@‘zl

Sharpen | Unsharp Mask |

Amount |—— 0 3

Undo All Undo Redo

@ Q M| —

B [Trim Image] Window

Selecting [Trim] from the [Edit] menu or the [Elex- icon allows you to crop a
still image. Either drag the mouse on the image or specify the cropping area,
and click [Trim Image].

=] Trim Image - C:\Documents and SettingsiCanoniMy Documentsi200X_01_15UMG_0103.IPG ‘:_JE@
Trirn settings
Location [topeft comer):
%[0 ]
v
~ Size of kimming area;
wn
H ‘D

T tim I

il @ Q s

Cancel
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B [Insert Text] Window

Selecting [Insert Text] from the [Edit] menu, or clicking the [Ei=t- jcon, and
select [Insert Text] allows you to write text on still images.

=] Insent Text - C:Wocuments and Settings\Canoniy Documentsi200X_01_154UMG_0104. JPG \Z|@E|

Insert Text
Font Name I@_;’J
Fort Size: |48 |

Text Color -

Text Attribute: B i U
[] Antiglias

Test

<Select the location on the image first, then
type your test in hers>

20 I Windows



| Installing the Digital Video Software

VG‘ O Be sure to install the Digital Video Software before connecting the
\ o /| camcorder to the computer. IEI
O Users of Windows 2000 or Windows XP must first log in as an Administrator
to install programs.

Windows XP Users:

Your digital video camcorder is equipped with the standard Picture Transfer

Protocol (PTP). This protocol enables you to download still images by simply

connecting the camcorder to a computer with the USB cable (the software such

as the [Scanner and Camera Wizard] starts automatically).

However, please note that there are several limitations to downloading still

images with this method. To avoid these problems, install ZoomBrowser EX to

download still images.

o It may take a few minutes, after connecting the camcorder, until you can
download still images.

o Still images protected on the camcorder may lose this setting once they are
downloaded to the computer.

1 Check a camcorder is not connected to the computer.
While a camcorder is connected to the computer, the software cannot be
installed normally. If a camcorder is connected, detach the USB cable from the
computer.

2 Close all programs that are running.

3 Set the DIGITAL VIDEO SOLUTION DISK in the computer’s
CD-ROM drive.

If the installer panel does not open automatically, use the following procedures
to display it.
- Windows 98/Windows Me/Windows 2000:
1) Double-click the [My Computer] icon.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [SETUP.EXE] icon.
- Windows XP:
1) Select [My Computer] from the [start] menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3) Double-click the [SETUP.EXE] icon.
Depending on the setting of your computer, the file extension “.EXE” may not
appear.

4 select your language.
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5 Cclick Digital Video Software [Install].

Canon DIGITAL VIDEO

Installer Panel
Solutlon Dlsk

Digital Video Software

QuickTime

Install

Exit

If the following dialog appears, click [Restart] to restart the computer. After
restarting the computer, installation automatically continues.

InstallShield )

Setup has niuﬁnpleted configuring the ‘windows
i Inat-:ﬂ'ler o y;lursyﬁtem The zuztem needs to be

: mstarted |n arder b continue with the installation,
Please click Restart to reboot the system.

6 Click [Next].

Welcome to the InstallShield Wizard for Solution
Disk

The InstallShield® \Wizard will inzstall Solution Disk on pour
computer. To continue, click Maxt

< Back <l Mexts ) Cancel
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1 select [Easy Installation] and click [Next].
To install the software individually, select [Custom Installation]. When you select
[Custom Installation], select a USB driver. (Windows XP: The USB driver
supplied with the Windows operating system is used. You do not need to install
a USB driver.)
» Windows 98/Windows 2000: Canon DV TWAIN Driver
* Windows Me: Canon DV WIA Driver

Canon Digital Yideo Solution Disk:

Setup Type L
Chooze the setup type that best suits your needs. I--“' e B

Click the type of Setup vou prefer.

> [ezcription

Inztallz all the programs. ‘wWe
recommend this option for uzers
urifamiliar with the inztallation.

< Back Cancel

8 Select your country/region and click [Next].

9 Read the license agreement and click [Yes].
10 Review the installation settings and click [Next].
* Installation starts.
* If the “Digital signature not found” message appears, click [Yes].

Canon Digital Yideo Solution Disk

Start Copying Files
Fieview settings before copying files.

Setup has enough information to start copying the program files, [F you want to review or
change any settings, click Back. |f you are satizfied with the zettingz, click Mext to begin
copying files.

Current Settings:

Destination Folder:
C:\Program FileshCanon
Frograms to be inztalled:

FhataStitch
ZoomBrowser Ex/PhatoR ecord

< Back <| Mext > ]> Cancel
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11 When installation is complete, select [Yes, | want to restart
my computer now.] and click [Finish].

Canon Digital Video Solution Disk

InstallShield Wizard Complete

The InzstallShield Wizard has successfully installed Solution
Dizk. Before pou can uze the program, wou must restart your
computer,

@nt to restart my com@

" Mo, | will restart my computer later.

Click Finish to complete setup.

Q Fsh D |

12 When the computer has restarted and the regular desktop
screen is displayed, remove the DIGITAL VIDEO SOLUTION
DISK from the CD-ROM drive.

When installation is complete, remove the DIGITAL VIDEO SOLUTION DISK
before you connect the camcorder to the computer.

O Windows 98/Windows Me/Windows 2000: At this point, the files for the TWAIN

<4 Driver or WIA Driver have only been copied to your computer. To download
images via USB connection, finish installing the TWAIN Driver or the WIA
Driver. For details, see step 6 ([1] 25) in Connecting the Camcorder to a
Computer.
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| Before Downloading Still Images

Connecting the Camcorder to a Computer

[E]

VG‘ O Be sure to install the Digital Video Software before you connect the
\ o /| camcorder to the computer.

O Make sure the camcorder is being powered using the power adapter before
connecting it to a computer.

o Connect the USB cable directly to one of the computer’s main USB ports.
The interface may not function correctly if the camcorder is connected via a
USB hub.

o The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this occurs,
disconnect the other devices from the computer and try reconnecting the
camcorder.

o Do not connect two or more camcorders to the computer. The camcorders
may not operate normally.

O Never allow the computer to go into standby (sleep) mode while a
camcorder is connected via the USB interface.

2%y © Refer to your computer manual for the location of the computer’s USB ports.

4 0o See your camcorder instruction manual for how to connect the camcorder to
the computer and how to change the media setting (MEDIA SEL.E3) in the
SYSTEM SETUP menu.

Insert a disc or memory card containing images into the
camcorder.

Connect the power adapter to the camcorder.

Turn the power switch to ON and change the camcorder
mode to PLAY by sliding down the power switch.

Move the’® | to ).

(3 ) I - W N -—

To download still images on the disc select DISC in the
MEDIA SEL.&3 from the SYSTEM SETUP menu.

To download still images on the card select CARD in the
MEDIA SEL.3 from the SYSTEM SETUP menu.

Wait until the camcorder’s access indicator stops flashing.

6 Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
* The first time you connect the camcorder to the computer:
- Installation of the DV TWAIN Driver (Windows 98/Windows 2000) or the DV
WIA Driver (Windows Me) starts.
- If the “Digital signature not found” message appears, click [Yes].
- If you are prompted to restart the computer, restart the computer.
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* Windows 98/Windows 2000/Windows XP: A window appears allowing you to
select an application program to start.
Windows Me: The Scanners and Cameras Wizard starts. Click [Cancel] to
close the Wizard.

* For instructions on how to start ZoomBrowser EX and download images to the
computer, see Downloading Still Images (ZoomBrowser EX) ([ 1] 27).

USB Terminal USB Cable

on tiamcorder E¢|:mﬂ E

~¢— Camcorder End Computer End —

USB Port on
the Computer
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| Downloading Still Images (ZoomBrowser EX)

@ O Proper operation when connecting to a computer or printer cannot be
\ o/ guaranteed if the disc inserted into the camcorder was recorded or used in a
non-Canon digital device.

o Observe the following precautions when the camcorder’s access indicator is
flashing. Failure to do so may cause disc or memory card data to become
corrupted.

- Do not open the disc or memory card cover, remove the disc or memory
card or detach the USB cable.

- Do not turn off the camcorder or the computer.

- Do not change the position of the power switch or the "™ /€3 switch.

o Images recorded onto the disc, memory card or downloaded to the hard disk
are important original data files. Create a copy of the file first before working
on it on your computer.

O For Windows XP Users:

- Do not rotate the image in the [Windows Picture and Fax Viewer] or in the
explorer view. The data for the original image will be changed and the
image can no longer be displayed in ZoomBrowser EX or on the
camcorder.

- If the Server Busy window appears when you connect the camcorder to the

computer, click [Retry].

: This action cannot be completed becauze the ather
' prograr iz busy, Choosze 'Switch To' to activate the
s busy program and carrect the problem.

O You cannot connect the camcorder to a computer if the disc or memory card
contains more than 1800 images. When using a memory card, please use a
card reader/writer to download the still images; for the disc, please use your
computer’s DVD drive. When using the DVD drive to download the images
recorded on the disc, it is necessary to insert a finalized disc.

- You cannot record any new images on the finalized DVD-R disc or
unfinalize it.

- For instructions on how to connect a card reader/writer, see Using a Card
Reader/Writer (1] 36).
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Starting CameraWindow

1 Connect the camcorder to the computer (11 25).

2 Select [Canon CameraWindow] and click [OK].
* If a camcorder and card reader are connected at the same time, a dialog
appears allowing you to select the camcorder model. Confirm that [Canon
Camera] or your camcorder model name is displayed and click [OK].

Canon ¥¥ %%

Camera connected

Select the program to launch for this action;:

_i7 2 Microsoft Scanner and Carmera ‘Wizard
=) R P
= Download pictures fram a camera of scanner

[ &lways use this program for this action

» The Camera Control window opens.

* If the window does not appear or if “PC CONNECT” does not appear on the
camcorder screen, click the Windows [start] menu and select [All Programs],
[Canon Utilities], [CameraWindow] and [CameraWindow].

&% CameraWindow - Canon 44+ &

Acquire Images P[F Et to Camera anote shoating

Downloads uzing camera

WL \9&“' Press the camera's button

F i
j;?—l Lets you select and download images

[] Displays this screen when the camera is connected

2Py O Ifthe camcorder is already connected to the computer, you can start the

& CameraWindow and display the Camera Control window by clicking [Acquire
& Camera Settings] followed by [Acquire Images] in the ZoomBrowser EX
Main Window.

o The Remote shooting function is not supported by your camcorder.
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Using the Computer to Download Still Images

You can select a downloading method in the Camera Control window.

B Auto-Downloading

1 Click [Starts to download images] in the Camera Control

window.

* For instructions on how to set the Auto-download settings, see Auto-

Downloading Settings ([1] 30).

* Click [Finish] to close the Camera Control window after downloading images.

& CameraWindow - Canon SFa sk ok
Acquire Images | Print | Set to Camera | Femote shooting

Downloads uzing camera

EWE ] \-'-’J&N Press the camera's button

b

Dizplays this screen when the camera is connected

Freferences...

Lets you select and download images

EE
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B Auto-Downloading Settings

Select the setting for downloading images by operating your computer. You can
change the image type and the destination folder.

1 In the Camera Control window, click the [Acquire Images]
tab and click [Preferences].

& CameraWindow - Canon .

' | Acquire Images !!Z‘rint Set to Camera | Remote shoating |

‘ Downloads uzing camera

¥ \fJ&N Press the camera's button

Downloads uzing computer

She
Ay
==

Starts to download images

i) i
j;?—l Lets you select and download images

Displays this screen when the camera is connected

| Preferences... |

2 Select [Change auto download settings] and click [Next].

CameraWindow - Auto Download Settings

wWhich download method do you want to perform setup for?

() Change direct transfer download destination folder

(@ Change auto download settings )

Cancel
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3 Select the image type to be downloaded and click [Next].

CameraWindow - Auto Download Settings(1)

Select the image type to be downloaded.

(=) News images
() &llimages
() Images whose print order settings were specified with the camera

{:} Images whoze tranzfer settings were zpecified with the camera

Download Options

Place a CheCk mark here — = | 'when the download iz complete. the ariginal image iz deleted from the camera.
if you wish the original image

in the camcorder to be

deleted after downloading. EEr N

@ o The still images recorded on the disc will not be marked as “already
\ o/ transferred” after downloading.
o When downloading from the disc, the still images on the disc will not be
deleted even if the [Download Options] is selected (a check mark is placed).

4 Specify the destination folder settings and click [Next].

Cameralfindow - Auto Download Settingsi2)

Specify the location at which to save the image.

Destination Folder
A new falder will be created for each of the images' shoating dates in the following falder,

and the images will be zaved there.
!

_ \Diocuments and & ettings \Cananihl y DocumentziMy Pictures
Click this button Browze. .
to SpeCify the Create Subfolder
destination fOIder. EhootingYearMonthDale v:
E xample:

. Z cA\D d SettingzhC. Whdp D My P
SeleCt tO SpeCIfy _]r::l 2%?;?5;;;5; ettiingshCanoniMy Docurmentssby Pictures
the name of the
subfolder.

< Back Cancel
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5 Specify a process to perform after the image is downloaded.

CameraWindow - Auto Download Settings(3) r)_(|

Specify process to perform after image is downloaded.

(=) Display the folder at the zave destination

() Perform selected processes consecutively

< Back Cancel

Below window will be displayed when you select [Perform selected processes
consecutively] (You can redisplay the window by clicking [Select]). Select a
process to perform after the image is downloaded, and click [OK].

Select Process

Pleaze select a tazk to run after your images
have been downloaded:

%) Yiew as a Slide Show
() One Photo per Page Frint
() Index Frint
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6 Click [Finish].

CameraWindow - Auto Download Settingsi4)

Enable or disable the image auto-download function. ﬂ

PIaCing a CheCk mark :| Imagesz are automatically downloaded to computer while camera iz connected
here makes images in
the camcorder to be
automatically downloaded
when the camcorder is
connected.

< Back Cancel

B Downloading the Selected Still Iméages from the CameraWindow

1 Click [Lets you select and download images] in the Camera
Control window.
The CameraWindow opens.

& CameraWindow - Canon Sk ko

Acquire Images | Print || Setto Eamer;”_ﬁemote shoating

Downloads uzing camera

WL ] \\y&N Press the camera's button
——

Diigplayz thiz screen when the camera is connected
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2 In the CameraWindow, select the image you wish to
download and click [Image Download].

» Clicking on 2 images while holding down the [Shift] key selects also all images
between the 2 images.

* Clicking on different images while holding down the [Ctrl] key selects multiple
images.

& CameraWindow - Canon k4K
File(F) EditfE) View(¥) Help{H)

_2| File Infarmation
File Name:  IMG_0101JPG

j @ Modified:  200/01/15714:43.28

File Size: BOKE
Image Size:  Gd0x480

*Z:Qﬁ‘,]lmage Download k\d Print * E@Start ZoomBrowser EX

B Select ~ =

= V'";r T FV 3
A blue frame —ﬁ vl

appears around
the selected image.

_#| Histogram:

IMG_0101PGE IMGE_0102.0PG IMG_0103.0PG IMG_0104.JPG

5| &1 Detals
Ttem Name Value A
File Mame: MG_010

Camera Model ... Canon
shaating Date/Ti... 1§15i200
Shooking Mode  Partrait
Photo Effect Off

To (Shutter Speed) 1j40

Av (Aperture Vel 2.0

Light Metering Evalustiv
Exposure Comp...
150 Sp ed Auto
2.6-65.1
an\ Length 7.9mm
Digitsl Zaam Hone
Image Size 640480
Image Quality Fine o
& >

Selects image 1 of 4

[Delete] from the [Edit] menu and & will not be active when transferring the
still images recorded on the disc.

3 Confirm the settings and click [Starts Download].

« ZoomBrowser EX starts, and the downloaded images appear in the Main

Window.
CameraWindow - Download Images
i New
|
ﬁi Download images according to the following settings.
"‘-.:
Specify Folder
Save to [Folder Mame]
. C:h\Documents and SettingshCanontbdy Documents
Setting for the folder and the
. Create Sub Folder
subfolder for downloaded images
Shooting 'earkd onthD ate
Specity File Mame \
Settings for the file prefix : Do not modify
and the consecutive numbers J
[ Change Settings. .. ]
m [ Cancel ]
\ /
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* To make changes, click [Change Settings].

[Specify Folder] Tab

CameralWindow - Change Settings

Specify the settings of
the folder and subfolder.

[Specify File Name] Tab

Specify the file name at — == Speciy File Name |

which to save the images.

Specify Falder |m|

Save to [Folder Mame]

|C:\Documents and SettingztCanon'ty Documents | L Browsze. .. ]

A zubfalder inta which the image will be saved will automatically be created in this folder.

Create Subfolder
|Shooting YearMonthDate vl

Example:

[_J CADocuments and SettingshCanoniMy Documents
-1 200%_01_15

]9 ] ’ Cancel

CameraWindow - Change Settings

Specify File Marme:

Agzion S equence Mo

[umber of Cigits: | 4

LR

[1s3)
Skt 10 (0000-5353)

E xample:

[ filerEBtenzion will be thedame a: the original file nam

ok ] [ Cancel
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B Using a Card Reader/Writer

The basic operations are the same as when you connect the camcorder to the
computer. Follow the procedure below to open the CameraWindow. For
instructions on how to connect the card reader/writer, please refer to its manual.

29y |f your card reader/writer does not support miniSD cards, please purchase an
4 appropriate adapter for the card.

1 Insert a memory card containing images recorded with the
camcorder into the reader.

2 Windows 98/Windows Me/Windows 2000: Click the Windows
[Start] menu, and select [Programs], [Canon Utilities],
[CameraWindow] and [CameraWindow].

Windows XP: When a window appears allowing you to select
an application program to start, select [View/Download
Images using Canon CameraWindow] and click [OK].

The Camera Control window opens.

3 Select a downloading method.

* [Starts to download images]: The progress bar will be displayed and images
will be downloaded to the computer, and ZoomBrowser EX starts. For
instructions on how to set the Auto-download settings, see Auto-Downloading
Settings ([ 30).

* [Lets you select and download images]: The CameraWindow opens,
displaying the camcorder images as thumbnails (small images).

& Camera¥indow - G:¥DCIM
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Using the Camcorder to Download Still Images (Direct
Transfer Function)

If your camcorder supports the Direct Transfer Function, you can use the
camcorder to download images. IE'

B Direct Transfer

1 Select a transfer option on the camcorder screen and press
the 0~ button.
» See your camcorder instruction manual for how to set and operate the
camcorder to transfer images.
* For instructions on how to change the destination folder and the folder name,
see step 3 ([ 31) in Auto-Downloading Settings.

« The 37 button cannot be used when it is not lighted.

* You can set the action that is carried out for direct transfer. Right-click the
[CameraWindow(Launcher)] icon on the taskbar and select an action from the
displayed menu.

- [Show image(s) in fullscreen mode]:

Displays downloaded images in v Show imagels) in fullscreen mode

full screen mode. v Launch ZoomBrowser Ex
- [Launch ZoomBrowser EX]: P4 N
Starts ZoomBrowser EX after v Show Window
downloading the images. 2 "W WA
- [Show Window]: | About CameraWindow(Launcher], .,
The Camera Control window | _ A
appears when you connect the Ei":

camcorder to the computer.

2 Press the 0y~ button on the camcorder.
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B Setting the Direct Transfer Download Destination Folder

1 In the Camera Control window, click the [Acquire Images]
tab and click [Preferences].

& CameraWindow - Canon, 3 Fk

' | Acquire Images |!3nnt Set to Camera | Remate shaoting |

Downloads uzing camera

7 .\\J)QN Press the camera's button

o8 -
j;_h!—l Lets you select and download images

Displays thiz screen when the camera is connected

| Preferences... |

2 Select [Change direct transfer download destination folder]
and click [Next].

CameraWindow - Auto Download Settings

Which download method do you want to perform setup for?

(G Change direct transfer download destination folder )

) Change auta downlaad setings

Cancel
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3 Specify the destination folder settings and click [Finish].

CameraWindow - Auto Download Settings(2)

Specify the location at which to save the image.

Destination Folder
A new folder will be created for each of the images' shooting dates in the following folder,

and the images will be zaved there.

CIle thlS button Browse...

to SpeCify the Create Subfolder

destination fOIder. :ShootingYearMDnthDate v|
E xample:

Select tO specify e | SZ%EL;?ES;S%M SettingshCanontbdy Documentzhhdy Pictures

the name of the

subfolder.

<Back (C Fiish D[ Cancel
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| Printing Still Images

Printing Still Iméages Recorded on the Disc or Memory
Card

You can select one of the following 4 methods to print still images in the disc or
card without downloading images to the computer.
* [Print All Photos]

- Prints all still images recorded on a disc or memory card in the connected

camcorder or in a card reader/writer one image per page.
* [Print Contact Sheet with All Photos]

- Prints all still images recorded on a disc or memory card in the connected
camcorder or in a card reader/writer in an index (rows of images on one
page).

* [Print according to DPOF settings]
- Prints according to the DPOF print settings set by the camcorder.
* [Select an image and print]

- A list of the still images recorded on a disc or memory card in the connected
camcorder or in a card reader/writer will be displayed, and you can select
images you wish to print.

1 Connect the camcorder to the computer. ([1]25)

2 Click the [Print] tab in the Camera Control window.

& CameraWindow - Canon, 34 3 3

Aciuire Image et to Camera | Remate shaating

Downloads wsing camera

[+] Displays this screen when the camera is connected
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3 Click one of the 4 printing methods.

& CameraWindow - Canon Sk ok

sl | i} ]|
| Acquire Images| Frint | Set to Camera | Remate shoating | ﬂ

Print All Photos

i

B,

Print Contact Sheet with All Photos

Print according to DPOF settings

R [

Select an image and print

il
L/LT7P

\

Diigplayz thiz screen when the camera is connected

J

4 Specify the print settings and click [Print].

The window varies depending on the selected printing method in step 3.
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When you have selected [Print All Photos]:

Sets the paper size Rotates still images.
and orientation.
Click this to use the trimming function
Selects the printer. (crops a portion of the still image).

Frinter Frewview

-y (& 3) =
t Trim Image

Canon M
| HXAHAR | Fotate Left  Ratate Righ

Properties...

(MediaType:

|Plain Faper v|

Faper Size: —

|Let‘ter V|

Orientatian:

\Q) Forrait O Landscape

Total: 4 pages
Page Layout Settings

Auto Trim

[] Barderless

Select additional infarmation
to print with your images:

[[] Shoating Date
[[] Shoating Time

Text Color: (|

4| Image: 1/4 E
L

]
Cancel

Click this button to switch between still images

Sets the auto trim if multiple images are selected.

(crops image edges

according to the page — Sets the number of print copies of the displayed image.
proportions) or

borderless print settings. =—Sets the shooting date/time imprint and color settings.
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When you have selected [Print Contact Sheet with All Photos]:

Sets the paper size Rotates still images.
and orientation.

Click this to use the trimming function
Selects the printer. (crops a portion of the still image).

index rin Sotings I I &)

Printer Srewview

Mame: : ";‘J-
C -
| el s —| Fuotate Left  Rotate Right )/ | Trim mage

Froperties...

Media Type:

=

| Plain Paper

Faper Size:

| Letter |
Orientation:

@ Porrait O Landscape

-~

Copies: j1 &

Tatal: 1 pages

Fage Layout Settings

Colurnns: 13

Fuows: 3

i1 (€2

\_

[¥] Shaating Information

[IHeader/Footer

.

4 Page: 1/1 »
1 ]

Cancel

Sets the print settings Click these buttons to switch between pages.

for shooting information, . .
comments; headers, — Sets the number of print copies of the contact sheets.

footers and page
numbers.

When you have selected [Print according to DPOF settings]:

* The selected still images will be printed according to the number of copies set
with the camcorder. The same window described in the previous section When
you have selected [Print All Photos]: ([T]42) will be displayed.

Sets the number of rows and columns.
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When you have selected [Select an image and print]:

* If you selected [Select an image and print], the following window will be

displayed. Select still images you wish to print, and click [Print]. If you selected
[Contact Sheet Print], the same window described in the previous section When
you have selected [Print Contact Sheet with All Photos]: ([]43) will be displayed.
If you selected [One Photo Per Page Print], the same window described in the

previous section When you have selected [Print All Photos]: ([1]42) will be

displayed instead. Set the print settings and print the still images.

&2 CameraWindow - Canon 4 45
File(F) Edit(E) Wiew(y) Help(H)

w3 Modified  200=/01
File Size 80 KB
Image Size: BA0x430

_# | Histogram:

B Select ~ = J

IMG_0101JPG IMG_0102.JPG IMG_0103.JPG IMG_0104 JPG

7'-‘-"'{'.‘ _%\ e _# | File Information
‘gg‘ Image Downlo(d L(_d Print - ﬁ Start ZoomBrowser ExX File Mame:  IMG_0101.JFG

A1514:4%3:28

5 _# | Detals

Ttem Mame Yalue A
File Mame IMG_010
Camera Model M., Canon
Shaoting Date/Ti... 1/15/200
Shooting Made Porkrait
Phato Effect OFf
Tv (Shutter Speed) 1740
Ay (Aperture Wal... Z.0
Light Metering Ewaluativ
Exposure Comp... O
150 Speed At
Lens 2.6 - 651
Focal Length 7.9 mm
Digital Zoom Mane
Image Size 640480
Image Guality Fine v

‘ < >
Selects image 1 of 4
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Printing Still Images Downloaded to the Computer

You can select one of the following 3 methods to print still images downloaded to
the computer.
* [One Photo per Page Print]
- Prints one still image per page.
* [Index Print]
- Prints a selection of multiple still images in columns and rows in an index
form.
* [Layout Print]
- Allows you to lay out the selected still images in special arrangements and
add texts and decorations, printing them as one page in a fancy album.

o5 Yqu can select the program to use for printing by clicking [Print] in the Main
: Window and selecting [Print Using Other Software].

B [One Photo per Page Print]

1 Click [Print] in the Main Window and click [One Photo per
Page Print].

=7 ZoomBrowser, EX - C:ADocuments and SettingsiCanoniMy Documents
File Edit Wew Tools Internet Help

[ Tasks 6 H Yigw Image Propetties @S\ide Shia @ Seatch "Q; [elste
tiequire & Camera Settin ] Zoom ode Sorol Mode I_:'rewew_Mode
= My Diacumenl ts € ‘@'Q'EQ ) Jn—wﬁ Shuw|AIHmages v

D Wiew & Clazsify ]
CE |
[@ Export ]
T
)
~

One Phaoto per F’age Frint.

I\

T]r

ndex Piint 7 e
Layout Print J =
IMG_Dl. IMG_0104. 3P
Frint Using Other Software
T -

2 Select still images you wish to print and click [Printer and
Layout Settings].

1 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documents

Zoom Mode | Scroll Mode | Freview Mode|

My Docurmen ts € + m -0 - |£‘Q J.,W Show | AllImages w

i bﬁi@mﬁc

|3 Pint
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Specify the print settings and click [Print].

Sets the paper size and orientation. — Rotates still images.

Selects the printer. Click this to use the trimming function

(crops a portion of the still image).

=7 ZoomBrowser X - C:\Documents and SettingsiCan|

BENET
Help

File Edt ‘iew Tools Internet Help

| STEP 2: Sp| |cify Printer and Layout Settin

‘ 1. Select Images ‘ Printer

MNarne:

I Printer and Lavout Settings ‘ | Canon xeooe: S

Media Type:

|Plain Paper ¥
\ p |

Fotate Left

Faper Size:

‘ Letter 7‘

1[4 RetumtoMain Menu

Orientation:

@ Portrait O Landscape

Tatal: 4 pages

Fage Layout Settings

Auta Trim
] Borderless

Selectadditional information
to printwith your images:

] Shoating Date
[] Shoating Time

TextColor [

Copies: |1 ‘:}

4 Image: 174 »

Click this button to switch between still
images if multiple images are selected.

Sets the number of print copies of the displayed image.

Sets the shooting date/time imprint and color settings.

Sets the auto trim (crops image edges according to the page proportions) or borderless
print settings.
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B [Index Print]

1 Click [Print] in the Main Window and click [Index Print].

&7 ZoomBrowser, EX - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Tools Internet Help
.ViEwImage 5 Propetties @S\ideﬁhnw @Search ﬁ Delete i:,a Rotate

Zoam Made | Scroll Mode ” Preview Mode |

Iy Documents € > 2 ‘@' 0- ‘a 'E{ M | :El: D-— |Shuw

[ Tasks

Acquire & Camera Settings }

ﬁ Wiew & Classify }
I@ Edit }
‘@ Erport }
[@ Frint }
LD ne Photo per F’age Frint J
~

)

T

| Index Print

Fayuu Frint

I
[ PFrint Using Other Software }

AT
Q@ Intemet

2 Select the still images you wish to print and click [Printer
and Layout Settings].

f||1

&1 ZoomBrowser EX - C:\Documents and SettingsACanoniy Documents
File Edit Wew Tools Internet Help

Print

3 Retun to Main Menu )
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3 Specify the print settings and click [Print].

Sets the paper size and orientation. —

Selects the printer.

& ZoomBrowsen EX - C:\Documents and SettinpsiCan| piiy Documents

File Edt ‘iew Tools Internet Help

1

Select Images Printer

Mame:

Printer and Lavout Settings ‘

| Canan xxxxx w

Media Type:

jPIam Paper Vi

Faper Size:

|Letter ~|
I 3 Retumn to Main Menu L

Orientation:

©Porrait O Landscape

Total: 1 pages

Page Lavout Seflinas

(Culumna
kRDws

Shooting Informatian

Settings..

[] Header/Foaoter

page numbers.

Rotates still images.

Click this to use the trimming function
(crops a portion of the still image).

B[
Help

Page: 1/1

b

Sets the number of rows and columns.

Click these buttons to switch between pages.

Sets the print settings for shooting information, comments, headers, footers and

Sets the number of print copies of the contact sheets.
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B [Layout Print]

A program called PhotoRecord is used to print under the layout print method.
* Please refer to the PhotoRecord Help menu for more details.

1 Click [Print] in the Main Window and click [Layout Print].

1 ZoomBrowser, EX. - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wiew Tools Internet Help

[ e— QJ B Z‘ Properties @s\ide Show @ Search Delete: [P Rotate
Eﬁ Acquire & Camera 5ettings
@ Wiew & Classify

l@ Edit
l@ Export
[@' Frint

One Photo per Page Print ]
Index Print J
<

)

—

L
| Layout Print
D —

FPnnt Using Other Software 7
i |
l Intemet ] |

Zoom Mode | Soroll Mode | Preview hode|

My Documents € + m'O' |E‘Q 4 : J_‘ Shaow | Al Images v

%) 200%_01_15 hy b uisic

IMG_0103.JPG  IMG_0104.0PG

by Pictures

2 Select still images you wish to print and click [Select
Captions for Printing].

7 ZoomBrowser BX - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Toaols Internet Help

L Select Images J
=!
|

=

| 2 Select Captions for Printing

-~ —

3. Open Lapout Print... F
OuLifieg

Zoom Mode | Seroll Mode | Freview Mode |

My Documents + + "3' 0 - | [ CNE : Ur,-r_--d‘?? Shuw|Aleages v

|41 200%_01_15

3 Select the image information you wish to include in the print
by placing a check mark and click [Open Layout Print].

l 1. Select Images Layout Print Settings

Select shooting information to attach to images:
Select Captions for Printing

Camment
[ File Name
Diate and Time

{ 2 OpenLapout Print...

Printing Still Images I 49



4 Click [2 Select Printer & Album Type] and select a printer

and album type.

Select the printer.

EI Untitled - PhotoRecord

File Edit “iew Album  Internet Help

Prirter

[ CAnon w0

: (
Select Printer Album Type
& Album Type
L [ Free Form |VJ
Incluce
Select Paper [ Front Caver
[ Back Caver

Decorate \_ [ Page Numbers
Album

) [ Borderless Jrinting

Select the album type.

My Album

5 Click [3 Select Paper] and select the media type, paper size

and page orientation.

* If you click [Decorate Album], you can change the theme (a consistent design
for background, photo frames and text frames), or set the design elements
individually. When you set the design elements individually, make sure to

select the target page.

* If you click [Add Titles & Captions], you can add titles and text, and change
font, font size, justification and color. Make sure to select the target page when

performing these changes.

My Album

Frot Caver

| WEFT
CANON K000
Phat
Select Printer L
& Album Type J Mediz Type
-

Paper Size
Decorate Page Crientation
Album \ @ o= y,
Add Titles
& Captions

)

Set the paper type and orientation.
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6 Click [4 Print], confirm the number of copies and other print
settings, and click [Print].
Printing starts.

=  \ |

(4 Q Print O
Pririt

| Ii:

[ cancelt bs

o S

Click and drag photos ar right-click for options

PhotoRecord automatically performs image correction for images shot with Exif
2.2 compatible camcorders and even other images, yielding high-quality prints.
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| Organizing Images

Applying Star Ratings and Keywords

This task allows you to apply ratings to your images from one star to three stars.
The Star Rating can be used as one of the search conditions, or for the selection
of images to be displayed in the Browser Window. The keyword can be used as
one of the search conditions.

1 Select the image to which you wish to apply the Star Rating
or Keyword, and select [View/Modify Keywords] from the
[Tools] menu.

s Internet Help

Manage kevwords, .,

Skitch Photos. .,

_uskormize, ..
Preferences...

2 Place a check mark next to the keyword you wish to apply,
or click on the stars for rating.

= Yiew/Modify Keywonds

Check or uncheck the baxes to change the way Kepwards are applied to the selected files. To add a new Kepword, type the name in the
text field belovs the desired category, and press the + button.
People: Flaces: Events: Others: )
[T Children [l Beach [ Birhday

[_] Family [ Sity [[J Holiday

[ Friends | | ClHome [ Party
L Y,
Select the star rating to assign to the selected files

(¢ Feset

2% © The default setting of the Star Rating is two stars.
=4 o You can display images according to Star Rating by selecting [Filter by Star
Rating] from the [View] menu.
O You can add and delete keywords, or change the keyword list in the [Manage
Keywords] window by selecting [Manage Keywords] from the [Tools] menu.
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Classifying the Images

This task allows you to classify selected images according to the shooting date.

1 Click [View & Classify] in the Main Window.

&7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Tools Internet Help

[ Tasks 6 ] _ Yizw Image (2 | Properties @Shde Shiw @ Search Delete R Ratate

L toquire & Camera Settings J Zoom Mode | Seroll Mode H Preview Mnde! .
i ————— My Documents € 4+ m -0 - |L‘Q % = J.‘ Shaow | Alllmages -
| L_ﬁ Wiew & Classify

%) 200%_01_15 My Music

@
| l@ Frint
I l Intemet

2 Click [Classify into Folder].

IMG_0101.JPG  IMG_0102.0PG

[ e —

=
|
|

7' ZoomBrowser, EX - C:ADocuments and SettingsiCanony Documents

File Edit Wew Tools Internet Help

|[ Tasks 6 ] ‘ Wigw Image F 5 @ Slide: Show ‘Q Search
| @ Ao e B s ] Zoom Mode | Seroll Mode | Preview Mode | -

= iy Documents L Lﬁ -0 - |M@£ Jz-—-‘" Shaw I-mlmagas v
‘ [Tréf Wiew & Classity

l View as a Slide Show

Y !
Lﬂename tuiltiple Files J s o
- == = — " =
| Clazsify into Folder | I
P~ - = <A T ™
rﬁearch 7 'y

3 Select the images you wish to classify and click [Specify
Classification Settings].

3] 200%_01_15

ST 5

Zoom Mode | Serall Made | Preview}ﬁ‘o&ﬂ

My Docurments L

Select Images |

i ———— |
( 2 Specify Classification Settings |
D —— W=
F Finish —.

; I Return to Main Menu ]
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4 Specify the folder structure and the saving folder and click
[Finish].

The selected images are classified into the specified folder.

1 ZoomBrowser, EX - C:\Documents and SettingsiCanoniMy Documents
File Edit Wiew Tools Inkermst Help

fiy into Folder

1. SelectImages ? haecify Folder Structure WWhen classifying by shooting \
4 date, ZoomBrowser EX will onky

3 folder struct
Specily Classification Settings 5 EEEDIBEEe classity photos with shooting
| _1 A ‘YearMothate V| clate information and skip over
= === - 2
% -5 photos without shooting date
‘ Firish D . "J Example Folder Structure information
] Ej ‘ = CADocuments and SettingsiCanoniivy Documents |
200%_0115 By default ZoomBrawser Ex

copies the original photos to the
nesw folders. To sawve space on
your computer, choose to mowve
the photos instead

[ “3 Return to Main Menu

Save ta Faolder

| ‘“Where would you like these folders to be created?

I_EJ @ Current Folder

'::J O My Pictures
O Specify Folder

= .\D"DCIJTHENIS and S etti‘ngs\(janun\mgf Documents

Copy or Mowve Images

@ Copy

(%j O Move /
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Renaming Multiple Files

This task allows you to rename multiple files at the same time, or to rename and
copy multiple files.

1 Click [View & Classify] in the Main Window.

1 ZoomBrowsen EX. - C:ADocuments and SettingsiCanoniMy Documents |Z||E||Z|

File Edit Wew Tools Internet Help

[ Tasks 6 ] ViewImage = Properties @S\ide Show @ Search Delete ¥ Fotate
E@ s e J Zoom Mode | Seroll Mode | Preview Mode |

| = < My Documents € 4+ H-0-(h& Jr—-'-" Show |7Eﬁmages v
IL':'  Wiew & Clagsify
J
N e —— ;

r@ Edit j ;5 200:£_01_15 Wy Music
| | A —

|

|

(B
Xz
| l Intermet

IMG_0101JPG  IMG_0102.0FG

2 Click [Rename Multiple Files].

7 ZoomBrowser BX - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Toaols Internet Help

@ Slide Show @ Search

Zoom Made | Seroll Mode | Preview Mode

Iy Dacuments + 3 J} -0 - E‘@; L Jr--—"" Show | All Images v

3 200%_01_15

Search

Clazzify into Folder 7

3 Select the images you wish to rename and click [Specify
Rename Settings].

7 ZoomBrowser BX - C:\Documents and Settings\Canon\My Documents

5 Zoam Mode | 5crall Mode | Preview Mode
elect Images

Iy Documents + 4+ E& -0 - |l“~§& Jr--"" Show I-E\Tmagss =
| 2 Specify Rename Settings
E‘?I]I]X_[ﬁ_] 5 My Music:

3 Finish

! e MG_0101. PG 0102,
5 Reunts Manben . En
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4 Specify the settings and click [Finish].

#7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniby Documents

Help

‘ 1. Select Images ‘

L Specify Rename Settings J

~
|

Renarming your photos can

Select how files should be renamed make searching for them much
easier.

@ Mew Name + Number

O Shooting Date + Number

123.JPG 456 JPG

l"|i1

© Mew Name + Shooting Date + Number
© Shaoting Date + New Name + Nurber

] Make copies of files

AD0TIPG A _OD2.JPG

Specify name: |HNEWNAME

r = By default, ZoomBrowser EX
Mumber of digits: 3 crestes and renames copies of
T _ the original photos. Tao save

| 3 Retumta bain Me

Z

Start number: 1 SPAcEe On your computer.

choose to rename the original

Example of new file name: photos instaad

MEWNAME_001 0
\ MOTE: The original data type (e will be retained /

Placing a check mark here makes copies of images with new names.
The name of the original images will not be changed.

¥y Torename a folder, select a folder, and open the [Rename Folder] window by
& selecting [Rename] from the [File] menu. Input the new name, and click [OK].
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Searching for Images

This task allows you to search for images by Star Rating, Modification Date,
Shooting Date, Comment or Keywords.

1 click [View & Classify] in the Main Window. ﬂ

You can also search for images by clicking [Search] on Application Tool Bar.
Please skip forward to step 3.

&7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documents

= |

File Edit Wew Tools Internet Help

T — =
[ Tasks @ ] @ Slide: shor \Q Search C
E@ e e J Zoom Mode | Serol Mode | Preview Mode

= S
( )

tdy Diocumen ts < 4+ l.ﬁ -0 - |1“§§ J,-——""‘ Shaw |-..&-I\Tmages Iti

3] 200%_01_15

Pl M usic:

IMG_0101.0PG  IMG_0102.0PG

2 Select folders and images from which you wish to search
and click [Search].

File Edit Wiew Tools Internet Help
[ Tazks 6] Froperties @ Slide Show @ Search ﬁ Delete !é‘
@ Acquire & Camera Settings

=
rbré;_a Wieww & Clazsify

Zoom Mode | Scrall Mode | Preview M.oél;|

My Dacuments €2 1 ﬂ' 0- \EQ i Jr—""— Shaw I’L’I\Tmages v

—I9[E

Wiew as & Shide Shiow

Rename Multiple Files

|
|
|
|

—

5
)
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3 Specify the search conditions and click [Start Search].
* The search results are displayed as thumbnails.
* Select at least one search condition.

1. ZoomBrowser, EX - C:\Documents and SettingsiCanoniy Documents
Fle Edit View Tools Internet Help

STEPZ: S

i °eoctseerh e @ Metch all conditions © Metch any cancition

Specify Search Conditions

Star Rating

Find images with the selectad star rating

Star Rating: + v

[ Modification Date

Start Search

Find images based on the date they were last modified

| 9 Retun to Main Merw

[] Shooting Date

Find images based on the date they were shat.

[J Camment
Find images that hawe comments containing the following words

[ Keywords
\ Find images wou have tagged with keywords. /

4 Click [Finish].
» To change the search parameters and perform another search, click [Specify
Search Conditions] and repeat steps 3-4.

7' ZoomBrowser, EX - C:ADocuments and Settings\Canony Documents

File Edit Wew Tools Internet Help

Help

1. Select Seach Region

l 2. Specify Search Conditions

L Start Search J
-

1.IPG  IMG_0102,JPG 10%.0PG  IMG_0104,JPG

1 —
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» The images of the search result are displayed in the [Search Results] folder.
You can print or copy these images to another folder. The images will remain
in this folder until ZoomBrowser EX is closed or another search is performed.

A

x| |nternet

| Favarite Folders | Al Folders

= @ Deskkop
= 1}'3 Iy Docurnents
%) 200%_o1_15
@ My Music
(¥ My Pictures

Ty oSty [
2 Search Results
|

s
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| Creating a Movie from the Still Images

Editing Movies

You can link still images, insert text and background music, and add effects. You
can also change the size of selected movies and save them as new files.

76‘ o If you are not using Windows XP, QuickTime 6.5 is required to edit movies. If
¥ it is not already installed on your computer, install it from the DIGITAL VIDEO
SOLUTION DISK. Place the disk in the CD-ROM drive and click QuickTime
[Install] in the installer panel.
o If you have an AVI file in your computer, you can use this function to edit the
file.

1 Click [Edit] in the Main Window.

7 ZoomBrowser B - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Tools Internet Help

T e e

[ Tasks 6;?] 1/ Slide Show \Q Search
@ Acquire & Camera Settings ]

=

I.}';_' Wigw & Claszity J
[ — ~
".@ Edit

ha 1
F@ Export 7
l@ Frint ]
l Intemnet ]

2 Click [Edit Movie].

Zoom Mode | Sorall Made | Preview Mode |

My Diocumen s 4+ H-0-|0R | Show | Al Image: v

2006_0_20

IMG_0107.JRG IMG_0108.
4.5_-. =

File Edit Wew Toaols Internet Help

= >
[ Tasks ng—; ] ;l Wiew T perties g E; Slide Show \a Search elete

| Zoom Mode | Seroll Mode | Preview bode |

Iy Documents + 4 H-0- | \ @4., _J——-—-—"" Show AI\.Images w

@ Acquire & Camera Settings

=L
I.'FE_' Wiew & Classify
l@ Edit

l Edit Image

o

My Music
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3 Select images and click [Arrange].
You can select multiple images or a folder to include all images in that folder.

£ ZoomBrowser EX - C:\Documents and SettingsiCanoniy Documents |Z||E||Z|

File Edit Wew Tools Internet Help

STERP1: Addi JES. Help
Zoom Mode | Scroll Mode | Preview hode |

My Documents € > 2 m' 0- @u 'E'{ i :.D: G-‘ | Show | Alllmages ~

3. Apply Effect

4 SetAudio

4 Arrange images and click [Apply Effect].

To change the order of images, select an image in the Storyboard Area and click
[Move Left] or [Move Right].

£ ZoomBrowser EX - C:\Documents and SettingsiCanonihy Documents |Z||E||Z|

File Edit Wiew Tools Internet Help

B Edimovie

1. AddImages

STEFR 2: Atrange images. Help

Arange

Ta anange images. select the image and click on the [Move Left] or [Move Right]
buttons. Rt CUEN

Arrange
e —e O
(3 Apply Effect EEE - Hatl

Ta set the play fime of ratation, select the image and click the butkan,
4 Setdudio

5 Save Play Tirme | Ratate J

Total Time: 00:10

Selected Ibems: 2

Plays back the movies Storyboard Area

being edited. Displays thumbnails of the
selected images. The images will
be linked from left to right.

Transition Box
Displays the symbol of the transition
effect between linked images.
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5 Apply effects to the images and click [Set Audio].

When you select [Apply effects to image.], you can use the following functions.

- [Text Effect]: Opens the [Text Effect Settings] window. You can enter text,
change the font and preview the effect.

- [Filter Effect]: Opens the [Filter Effect Settings] window. You can set the filter
effect type, the start and end point, and preview the effect.

- [Magnify Section]: Allows you to view a part of the image in enlarged size.

- [Transition Effect]: Opens the [Transition Effect Settings] window. You can
set the transition effect type and display time, and preview the effect. To set
a transition effect, you need to select a transition box in the Storyboard Area.

&7 ZoomBrowser, EX - C:ADocuments and SettingsiCanon'My Documents

File Edit Wiew Tools Internet Help

effects to images.

Image Effects
1. AddImages () | Ise imane as i

=
() Apply effects to image.

2. Amange ] @@@ To set the Text effect, Filter effect, or to magrify a section, select the image and click the
“ appropriate button.
Apply Effect "” [ ] [ ] [ ]

Tent Effect Filter Effect I agrify Section

w =\
|

L IN_/

-

WWhen you want to zet the image's Transition effect, select the [Trangition E ffect] box and
click the [Transition E ffect] buttan,

-
m
=

6 Set the audio and click [Save].

When you select [Set audio.], you can use the following functions.

- [Add Audio]: Opens the [Add Audio] window. You can add a MP3 or a WAV
file as background music.

- [Advanced Settings]: Opens the [Advanced Audio Settings] window. You can
adjust the audio level of a movie or an audio file and apply audio faders. To
set the advanced audio settings, you need to select a movie or an audio file
which you added.

&7 ZoomBrowser EX - C:3\Documents and SettingsyCanoniiy Documents

File Edit Wew Tools Internet Help

—d A "
Lp';'wl Edit Mowie | STEP 4: Set audio.
A
1. AddImages NN 1] 2200 A L P S
(3 Set audio.
l 2 Amange To add audia, click the [Add Audia] buttan,
l 3. Apply Effect

Add Audio

L Set Audio To zet advanced audio settings, select [4udio] and click the [4dvanced Settings] buttan,

=
Advanced Settings
L <

B Exit 7

—
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Click [Save].
Movies are saved in DCF type files with Motion JPEG/AVI compression.

&7 ZoomBrowser EX. - C:ADocuments and SettingsiCanoniby Documents

File Edit VYiew Tools Intermet Help

the edit results.

Save file
1. AddImages File name:
:
2. Arange e
- Save to folder:

3. Apply Effect

|E:\Documents and Settings\CanonMy Documents | [ Browse

Save image type
4. Setbudio o=

%) Auto-select
() Specily a save image type

[ Save

[ S it

|Save image bype:otion]PEG [44])
lImage Size: 320 » 240 [Standard)
[Frame Rate:15 Frames/second
Audio:16 bit, 22,050 kHz, Monaural
Total Time: 00:10

Click [Save] button to save the edit results.

[ 3 Retum to Main Meru ]

Select this to save as Motion JPEG compressed AVI.

Selecting [Specify a save image type] and clicking [Advanced Settings] allows
you to set [Image Size], [Frame Rate] or [Audio] settings of the movie.

Click [Exit].

1 ZoomBrowser EX. - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Tools Internst Help

Save file

1. AddImages File: name: |

| =
2 Amange I%

| Save to foider

|
_\
_[
[

3 AplyEffect |E'\Dncumenls and Settings\Canoniky Documents | [ Browse ] I
i Save image bupe T i
4. SetAudo | (5 Buto-select
() Specify a save image lype
L Save MorichIPER 1) P advanced Settings

—

‘S'a'vé'in'i'a'ga t}pe:MoliDP\JPE‘IG"[AV ]
Image Size: 320 % 240 [Standard]
D £ Frame Rate: 15 Frames/second

T

udic: 16 bit, 22,050 kHz, Monaural
otal Time: 00:10

B Click [Save] buttan to zave the edit results

Save

I Return to Main Meru
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Playing Back Movies

In the CameraWindow and Main Window, movies are displayed with the first

scene as a still image with a IZ1 (movie) icon.

2Py O If you are not using Windows XP and QuickTime 6.5 is not already installed

& on your computer, install QuickTime from the DIGITAL VIDEO SOLUTION

DISK.

O Do not double-click a movie file (.AVI extension) in Windows Explorer. That
will start Windows Media Player, which may not support this file type. To play

back movies, double-click the thumbnail with a movie icon in the Main

Window’s Browser Area.

1 In the Main Window, double-click a thumbnail with a

(movie) icon.
[Image Viewer] window appears.

7 ZoomBrowser BX - C:\Documents and SettingsiCanoniMy Documents

File Edit Wew Tools Internet Help

[ Tasks

P—
L@’ Acquire & Camera Settings

]

|

[';E; View & Classity ]
|

|

= =
1/ Slide Show \Q Search

Zoom Mode | Soroll Mode | Preview hods |

Favarite Folders | Al Folders
ERE] Deskkop
(=} My Dacumen ks
=) 200%_01_20
T‘. My Music

H| | MWI_D106 AT

My Document b5 + k' 0 -

GDlD?.JP§D108.JPG MG _0109.FG

The [Image Viewer] window is displayed, and the movie will be played back.

You can control (Play back/Stop/FF/RW) the movie being played back with the

buttons shown at the left bottom of the window. If you are using Windows XP,
you can extract still images from the movie. For details, please refer to
Extracting Still Images from Movies (Windows XP Only) ([1]73).
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You can save the displayed scene as a still image.

You can play movies and control the sound volume.
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| Exporting Images

You can change the data type for selected still images and movies and save
them as new files. You can also export selected movies and still image properties
to a text file or copy and rename movies and still images. Furthermore, you can

export still images for use as a screen saver or a wallpaper.

Changing the File Type and Save

1 Click [Export] in the Main Window.

7 ZoomBrowser EX - C:ADocuments and SettingsiCanon'My Documents

File Edit Wew Tools Internet Help

E@ Edit
l Internet

=
[ Tasks & ] ﬁ‘? Slide: Show Q Search
ll@f‘ - ] Zoom Mode | Soroll Mode | Preview Mode :
= My Documents 4 L R0 - [ & & el Show | Allimages y
l }_;- Wiew & Classity ]
J s} 200%_01_15 My Music
-

m ,

LN

IMG_0101.JFG  IMG_0102.0FG

2 Select the export type.

If you selected [Export Movies], [Extract frames from a movie] or [Backup to
CD], please refer to the pages listed below.

[Export Movies]: Exporting Movies ([1] 70)

[Extract frames from a movie]: Extracting Still Images from Movies (Windows
XP Only) ([1173)

[Backup to CD]: Saving on CD-R/RW Disks (Windows XP Only) (] 76)

7 ZoomBrowser BX - C:\Documents and SettingsiCanonMy Documents

File Edit Wew Toaols Internet Help

[ Tasks 6 ] | liew Image 5 @7 Slide St I@ Search
l I.?;é}' Wien & Classify I 2 Zoom Mode | Scroll Mode | Preview Mode) ,
My Documents = - 8 ] Show | Alllmages v
l@ Edit l —
200X_01_1540 My Music

@ Export ‘ .’ il

(l Export Still Images P ‘ ‘ ‘

l Expart Movies l H

l Extract frames from a movie l

l Expart Shooting Properties l 3 i

l Expart 35 a Screen Saver l - SN

< IMG_0103, PG IMG_0104,IPG
Expart 53 a‘Wallpaper
| | My Pictures

\ Backup to CDv ]

l% Print ‘ ‘
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Select images and click [Specify Export Settings].

&7 ZoomBrowser, EX - C:ADocuments and SettingsiCanonMy Documents

File Edit Wew Toaols Internet Help

. [ 3 Return to Main Menu

STEP 1: Selectlmages

Zoom Mode | Scroll Mode | Preview Mode |

Help

+ H-0-[hQ &

My Documents &

! _ Shaw | &llImages 7

4 200¢_01_15 My Music

iENEpnpRpEe [MG_0102.0PG

4 Specify the export settings and click [Finish].

The window varies depending on the selected export type in step2.

When you have selected [Export Still Images]:
You can convert still images to another file type, resize and save them as new

files. You can select the file type from BMP, JPEG and TIFF. You can also specify
a prefix to be added to the exported still images.

7 ZoomBrowser EX - C:\Documents and SettingsiCanoniMy Documents

File Edit Yiew Tools Internet Help

@ Export Still Images

l 1. Select Images

|

=

D

1 Retumn to Main Menu

~

|

L Specify Export Settings J

Image Seftings

|§| [ Resize images during expart

Long side;
I §
IE:I 800 | pixels
(B ] P

Shortgiicles
[ B (e
le—l

[J Change image type

k i| (S0 B . Hligh

828KB
KB

Original File Size
Modified File Size:

Calculate

File Name Sattings

c: [ &dd a prefix [

Saveto Folder
O My Pictures

EV
O Specify Foldar

@ Current Folder

Q\Do:umems and SettingsiCanonihy Documents

BN

“ou can reduce the amount of
memory your files use by
resizing the images to a smaller
size

When exporting images as
JPEGs. you can also reduce file
sizes by using a lower Quality
setting which compresses the
image more. The images won't
look as sharp but the file sizes
will be smaller
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When you have selected [Export Shooting Properties]:
You can select the information you wish to export and save as a text file.

7 ZoomBrowser, BX - C:\Documents and SettingsiCanonitby Documents

File Edit Yiew Tools Internet Help

Select Images Expurt Settings Shaooting properties are stared

Select shooting properties to export: inimages as EXIF information.
Specily Export Settings

Active AF Points A EXIF stands for Exchangeshle

AF Mode I Image File Format and is used

[¥] AF Range Mode = by most camera manufacturars

utnexposure Bracketing =l
o Aperture Value )

Digital Exposure Compensation
[v] Dinsital Zanm

[ selectal ][ clearal |

E3

1 Retum to Main Menu
Save to File

Specify file name and folder:

|C\Ducument5 and SettingsCan \?BShootingProperies bt

MOTE: Properies will be sawved as *tt

Files without shooting properies will not he exported /

When you have selected [Export as a Screen Saver]:
You can export and save the image as a screen saver.

&7 ZoomBrowser, EX - C:\Documents and SettingsiCanoniky Documents

File Edit Wiew Tools Internet Help

‘ 1. Select Images ‘ Screen Saver Seftings The arder inwhich you select
[] Include images in the screen saver (larger file size)

photos determines their
L Specify Export Settings J sequence inthe screen saver.
7 \ Resizeimages J2dx7BR ltyou selected to include
images in the screen saver, you
= = Screen saver size KB Calculate can reduce their size tofita

different screen resolution

[]Setas default screen saver
i you choose notto include

images in the screen saver, and
[ Preview Screen Sawver. J
wou then mowve or rename these
R images. they will not display
when the screen saver plays.
Save toFile- L s

9 Retum to Main Menu

The screen saverwill be saved as
(& "ZhScreenSaver.scr” in the defaultWindows directon for
SCIEEn Savers

(O Specify file name and falder " Sayees

wTE: The screen saverwill be saved using the file extension * scr /

Exporting Images



When you have selected [Export as a Wallpaper]:
You can export and save the image as Windows wallpaper. This task cannot be
performed if you have selected multiple images.

#7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniby Documents

| 3 Retumta Main Meru

STER

Save to File

=)

( Installation Setings Stretching small photos can \

@ Install centered
O Install stretched
O Install tiled

O Do notinstall

The wallpaperwill be saved as:

@ "ZBWallpaper bmp" inthe default directory for wallpapers

O Specify file name and falder

\NOTE: Wallpapers are saved as hbitmap images (*hmp)

Help

pixelate and distart the photo
Try choosing Install centered or
Installed tile

Tiling replicates the photo. in its
original size. 1o fitthe deskiop.
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Exporting Movies
You can change the size or data for selected movies and save them as new files.

@ If you are not using Windows XP, QuickTime 6.5 is required to export movies. If

\&¥] it is not already installed on your computer, install it from the DIGITAL VIDEO
SOLUTION DISK. Place the disk in the CD-ROM drive and click QuickTime
[Install] in the installer panel.

1 Click [Export] in the Main Window.

&7 ZoomBrowser, EX - C:ADocuments and SettingsiCanon'My Documents

File Edit Wiew Tools Internet Help

[ Tasks @ ] Imag @ Slide: Show @ Seatch
@ Acquire & Camera Settings

[rT—é Wieww & Classity
L@ Edit

Erport
F@ Frint
l Intemet

Zoom Mode | Scrall Mode | Preview Mode

tdy Documents + I_:I_}' -0 - |1‘@~'§ J,-f—""‘ Shaw [KHTmages v.

200<_m_20 Bty M usic:

l——'—ﬂ

rél
_/l

IMG_0107.0PG  IMIG_0108.JPG

LB

e €2 et

2 Click [Export Movies].

7' ZoomBrowser, EX - C:ADocuments and SettingsiCanony Documents

File Edit Wew Tools Internet Help

| [ Tasks ) 6 ] . @ Slide: Show @ Search % Dl TRL

| rr;\’ View & Classily l i Zoom Mode | Scrol Mode | Freview Mode |

l My Diocuments €« > 4 [-0- ‘@l e Jr-—""" Show |-E-I\Tmagas =1l
@ Edit

I@ Erport l
[ Export Still Images Jl ||
| ExpullMlees |

[ Extract frames from a movie ~J
||
'=.|| |
Expart Shooting Properties = -
l Expart 83 & Screen Saver l £ b |
< 9,096 MYI_0106.441
Expart a5 a'wWallpaper
Backup to COV J
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Select a movie and click [Select the save image type].
You can select multiple images or a folder to include all images in that folder.
Still images cannot be selected. For instructions on how to export still images,

see Exporting Images ([ ] 66).

&7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Tools Internet Help

Zoom Mode | Scroll Mode | Preview Mode |

Help

t H-0-

My Documents

Aa] |

L _ Shaw | &llImages ¥

200_01_20

[ 4 Specify name of file to be saved

A

IMG_0107.JPG  IMG_0108.JPG

5 Start export

F Set the save image type T

IMG_0109.0PG L%

J

[ 3 Return to Main Menu

Bty M usic:

Select a file type and click [Set the save image type].

1. ZoomBrowsen EX -

C:\Documents and SettingsiCanoniMy Documents
Fil= Edit View Tools Internet Help

Save image type

%

| MotionPEG (Av1] ~|

\Standard movie file used on cnn"vputé;s
'V'ou can et the image size, frame rate and image quality
|\n the nest step,

Rotation settings

— ; DF\Ulale.i
..

[ 3 Retun ta Main Menu ]
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Specify the export settings and click [Specify name of file to
be saved].

&1 ZoomBrowser EX - C:iDocuments and SettingsiCanoniMy Documents

File Edit View Tools Internet Help

@ Export Movies STEF 3: Set Motion JPEG (&41).
1. Select Movies ﬂnage Size \
| (%) No change
2. Select the save image tpe © Zoom specification 50 %
| () Size specification 320% 240
Set the save image type
| — Fix the aspect ratio
| 4 Specify name of fils to be saved ) S
= — =
5 Start expart
: Image Guality
a
™ ;
Lo Standard High
2 i = Audio
Automatic v
[ 3 Retun ta Main Menu ] \ )

Specify the file name and click [Start export].

In each case, specify the destination folder and file name of the movie to be
exported.

1 ZoomBrowser BX - C:ADocuments and SettingsiCanony Documents

File Edit Wew Tools Internet Help

1. Select Movies

File Mame setting —_— = — E— -

(%) Same as original image

. Select the save image type () Azsign Sequence Mo,

abc |

Slh
e |
5 =

Specify name of file to be
saved
Sl
b

3. Setthe save image bype
e
Start export Save ta folder
|E' SDacuments and Settings\Canonhy Documents [ Browse

[Save image twpe information]

Save image lype:Motion PEG [&41]
= [Image Size:Mao change

[Frame R ate:dutomatic

\Image Quality: Standard

Audio:Automatic

3 Return to bain Menu

Destination Folder

Click [OK].
The Main Window appears.

MovieExport Task

Export is completed.

@ Details ==

Exporting Images



Extracting Still Images from Movies (Windows XP Only)

You can extract still images from movies and save them as image files.

1 Click [Export] in the Main Window. ﬂ

=7 ZoomBrowser, EX - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wew Tools Internet Help

[ Tasks 6} |g| Siew Image Properties @S\ide Show @ Search ﬁ Delete l.éﬁ Rotate

@ Acquire & Camera Settings }
@ Wiews & Classify }
Edit J

)

Zoom Mode | Seroll Mode | Preview Mode |

My Documents € > 4 \@ 0- \-&l ‘-{ i | D D-‘ |Shnw AllImages

File Edit Wew Toaols Internet Help

[ Tasks a} ,E| Wigw Tmage Froperties @S\ide Shiaws @ Search T‘%‘]’ Delete % Ratate

'|@ Wiew & Clazsify

o) Zoarn Made | Scroll Mode ” Freview Mudel

Iy Documents € > 4 @'Om ”:'{ i) :D: }‘ Shaw | All lmages iV

|

[@ Edit J
e %
J

l Expolt Movies

Expart Shooting Properties 1 =
Expart a5 a Screen Saver i
I <
Expart a3 a‘Wallpaper
Backup to CO .
& e H)

3 Select the movie from which you wish to extract still images
and click [Set extraction method].

——

1 ZoomBrowser, EX - C:ADocuments and) SettingsiCanonMy Documents
File Edit Wew Tools Internet Help

m” Fresviem Mode|
My Documents . ' t @' o it k @l -" v :Di F e b

. Preview image

4. Setupsave

. Perfarm processing

I Return to Main Menu
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4 Select the still images extraction method and click [Preview
image].

* [Extract all frames]: Extracts all frames in the movie as still images.

* [Specify an interval and extract frames]: Extracts frames as still images from a
specified frame range or time interval.

* [Specify the number of copies and extract frames]: Extracts a specified
number of still images from the entire movie. The extraction interval is
calculated based on an equal distribution of the specified number of still
images.

* [Extract a specified image]: Extracts still images from scenes that catch your
attention.

7 ZoomBrowser BX - C:ADocuments and SettingsiCanoniMy Documents
File Edit Wew Toaols Internet Help

File: name:p1_0108.441
Play time:00:07.00
Total frames:105
Image Size: 3204240

@cl o b ewtract the still images from the movie. \
() Extract all frames

Extracts every frame in the mavie az a still image.

> =— = J
| 3. Preview image J
D — ~

4. Setupzave 7

l 8. Perform processing

() Specify an interval and extract frames
Specifies the interval at which stil images are extiacted from the maovie.

() Specify the number of copies and extract frames
M= Specifies the number of copies of still images to be extracted from the mavie

B =
:-. Copies

() Extract a specified image

i_-| 5 Extracts the frame you select while watching a preview of the movie as a il
"’L = image.
k - /

I Fieturn to Main Meru

|
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5 confirm the still images extracted and click [Set up save].
If you selected [Extract a specified image] in the previous window, the movie will

be displayed in the upper part of the window. Display the images you want and
click [Add].

&7 ZoomBrowser, EX - C:ADocuments and SettingsiCanoniMy Documents
File Edit Wew Tools Internet Help

1. Select movie

2 Set extraction method

Preview image

Set up save

[ reomanvns |

00:01.22

6 Specify the file name and the folder where you wish to save
it and click [Perform processing].

1 ZoomBrowser EX - C:ADocuments and|Settingsi\CanoniMy Documents

File Edit Wew Tools Internet Help

STEP -

] File Mame - T
1. Select movie o i3
() Use original mavie file name

a c {0 Speciy & fils name:

2 Setetraction method

3. Preview image

Save folder

) Save in same folder as original movie
— ) Specify the save folder
‘ . | Browse

rAuln falder creation

Set up save

Perform processing

(2 Automatically create a folder with the same name as the original movie

Gpecily folder name for auto creation J

<Save Contents>

Saved images: 105

Image Size:320:240

Required disk space:&pprox. 2 8MB

Save to folder. C:\Diocuments and SettingstCanon'bdp Documentsh2006_01_2044WI1_0106

I 9 Feturn to Main Menu ]
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Saving on CD-R/RW Disks (Windows XP Only)

You can copy and save images to CD-R or CD-RW disks. The shooting
information is copied along with the images.

70\ This function can only be used on a computer that came with a CD-R/RW drive
\&¥] as standard equipment.

1 Place a CD-R/RW disk in the computer’s CD-ROM drive.

2 If the following window appears, click [Cancell].

CD Drive (F:)

Windows can perform the same action each time pou inzert
a dizk or connect a device with thiz kind of file:

7 Blank CD
“WWhat do pou want Windows to do?

| _ :-l ;! ] _ E #plorel
® Take no action

|
L

[] Always do the selected action.

o

3 cClick [Export] in the Main Window.

7 ZoomBrowser BX - C:ADocuments and Settings\Canon\My Documents
File Edit Wew Toaols Internet Help

i : C o o)
[ Tasks [ ] iz Spettie @Psm eshow (0 sesreh e

Zoom Made | Scrol Mode | Preview b eview hode

L@ Acquire & Camera S ettings . - £l
| Iy Documents "é' 4+ k-0 - \ -8 _}~—-——"" Show | Alllmages w

s —
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4 Click [Backup to CD].

£ ZoomBrowser EX - C:\Documents and SettingsiCanonihy Documents
File Edit Wiew Tools Internet Help

[ Tazks 6} E Wiew Image Properties @S\ide Show @ Search ﬁ Delete E& Rotate

@ View & Classify J@l Zoom Mode | Soral Made | Preview hods |
[@ My Documents ‘@l a M| = D__ | show
Edit

[@ Export

Expart Still Images

Expart Movies

Expart Shooting Properties

Expart a5 a Screen Saver

~

|
|
| |
l |
[ Extract frames from a movie J
| |
| |
)

L Expart a3 & Wallpaper

5 Select the folders or images you wish to save and click
[Specify Backup Settings].

mBrowser, BX - pcuments and Se iy Documents

File Edit Wiew Tools Internet Help

Zoom Made | Scroll Made | Preview Mode

My Dacuments ? i '5{. ‘ :D: P | Shaw | Alllmages ~

Select Images

(| 2 Specify Backup Settings

3 Start Backup

1 RetumtoMain Menu
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6 Set the backup settings and click [Start Backup].

The disk will be ejected from the drive when copying is complete.

&7 ZoomBrowser EX - C:ADocuments and SettingsiCanoniby Documents

File Edit View Tools Internet Help

@ Backup to CD

Select CO-R Drive:

.(_
AN/

Specify Backup Seltings

CD Title:

3. Start Backup

Speed: ‘Faslesl V|

Werify after backup

Use the Verity feature to testthe data on the CO-R after backupis
complete. This will take longer. butwill determine whether the backup was
successhul

Space on CO-R;

9 Retunta Main Menu Ussd 0.00 B, Currant Session 122 81 KB, Remaining 702 70 ME

(]

100 200

(1) The file sizes above are estimates anly. The CD burning process

may not be completed i the remaining space is low,

‘ 1. Select Images ‘ ( Backup Setings The speed atwhich your \

computerwrites (hums) data to
the CD affects the CD quality.

In general, slower recording
speeds create CDs that are less

prone to errors

ltis always a good idea to

choose "erify after backup' to
ensure thatthe backup was

successiul.

)

@ You can add images to a CD-R/RW disk that already contains images.
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Adding Still Images from Your Computer to the Memory

Card

You can save still images (JPEG) from the computer to a memory card of the

mix from the DIGITAL VIDEO SOLUTION DISK.

camcorder and a card reader/writer. You can also save sample images for card ﬂ

’0\ Unable to upload the still images to the disc.
\ o /|

B Adding Still Images to the Memory Card

1 Connect the camcorder to the computer (11 25).

2 Click [Acquire & Camera Settings] in the Main Window.

&7 ZoomBrowsen BX - C:\Documents and SettingsiCanoniy Documents

File Edit Wiew Tools Internet Help

[ Taoks 2} @ Slide show ‘a Search

‘ | Zoom Mode | Soroll Mode | Preview Mode|

3 200%_01_15

[ com
@
l Intermet

3 Click [Set to Cameral].

=
—_ —— € 3 4 (B-0-[hQ
7 .MyD t
|
|
|
|

File Edit Wiew Tools Internet Help

[ Tasks

I@ Aequire & Camera Settings

Acquire Images

J| Wigw T Praperties ,rj P Slicke Show: {a Search ;} F

Zoom Mode | Soral Made | Preview Made

iy Dacumen ts < + N-0- _7571@;'«. _}—""‘" Show "A.I\.I"magas

Frint Images

—

;

0 R /I K ]I

Set to Camera

Tl

Remote shoating

=

fia—r

I IMG_0101JPG  IMG_0102.0PG

—_]

Wiew & Clagsify
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4 Click [Uploads images to the cameral].

& CameraWindow - Canon k4 %

Acquire Images | Print | Set to Camera | Remote shoating |

Set My Camera

=

%F Confirmsf{changes camera settings

il

_}ﬁl Uploads images to the camera

Diigplayz thiz screen when the camera iz connected

D select the still images you wish to save and click [Open].

Upload Images from Disk

Loskin L_;TLE o115 v o @& E
SAY S
MG_0101 [1rG_Di0z} 1MG_0103 .
Fil e [MG_0102JFG 1HB_101 JFG" j;
Flesof yps: | peal'pa [ ]
6 Select the image size and click [Add].
Add image g|

Image will be added after setup iz performed.

(%) Add image as is
() Send after changing the image to VG size [B404450 dats)

Cancel

’0\ When you upload images edited with another application, images properties
\&¥ may be lost.
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B Adding Sample Images to the Memory Card

You can save sample images for card mix to the memory card of the camcorder

and a card reader/writer. CARD CHROMA, CARD ANIMATION, CARD

LUMINANCE and CAMERA CHROMA are provided on the DIGITAL VIDEO

SOLUTION DISK. ﬂ

76‘ o The sample images provided on the supplied DIGITAL VIDEO SOLUTION
\ o/ DISK are intended only for personal use with this camcorder. Do not use
these sample images for other purposes.
o Unable to upload the sample images to the disc.

1 Connect the camcorder to the computer (11 25).

2 Insert the DIGITAL VIDEO SOLUTION DISK to the
computer’s CD-ROM drive.

If the installer panel opens, click [Exit] to close it.

3 Click [Acquire & Camera Settings].

=7 ZoomBrowsen EX - C:\Documents and SettingsiCanoniMy Documents
File Edit Wew Tools Internet Help

Tasks @ DP Slide: Show “a Search
[ T - —
L@ Acquire & Camera Settings

‘\
p_—— 7
ﬁ"%—r Wiew & Classify 7

Zoom Mode | Sorall Made | Preview Mode
UUUUUU 13 ‘%’ éh -Q' . ©

Show "A.H.I"mages

¥ 200%_01_15

l@ Ecit
l@ Eport 0¥ =
@ |

l e / IMG_D%I IMG_qu

4 Click [Set to Camera].

7 ZoomBrowser EX_- C:\Documents and Settings\CanoniMy Decuments
File Edit Wew Toaols Internet Help

[ Tasks @] Tmage: Iiii ies @S\ide Shiow [Q Search

l@ Acquin e S0 T ] ZoomMode | Scroll Mode | Preview Mude! : S —
My Decumen b + + H-0- (kR e Show | Allimage: =

IMG_0101.0PG  IMG_0102.0PG
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5 Click [Uploads images to the cameral].

& CameraWindow - Canon k4 %

Acquire Images | Print | Set to Camera | Remote shooting-i

Set My Camera

%j: Confirmsf{changes camera settings

:fﬁl Uploads images to the camera

il

Diigplayz thiz screen when the camera is connected

6 In [Look in:], select the CD-ROM icon, and double-click [DVC

CARD IMAGE].
Sample images or folders for CAMERA CHROMA, CARD ANIMATION, CARD

CHROMA and CARD LUMINANCE appear.

Upload Images from Disk @@
Look in: | () CanonDVTocxdw [E-) ¥ Q & e E-
- — -
o
e .
DVC CARD IMAGE MANUAL QUICKTIME
v
Flensee | ]
Fles of type: | jpec” jpg) v

7 Select the sample images you wish to save and click [Open].

Upload Images from Disk

il il AT _0011,IPG
Flrne: U1 0011 a1 00037 1_001 (_oen 1)
Cancel

Files of type: | ipegl”.ipg) he
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8 In the Add image window, click [Add].

The sample images are saved in the memory card.

Add image

X]

Image will be added after setup iz performed.

(%) Add image as is
(") Send after changing the image to VG, size [B40<450 dots)

Cancel
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| Using Various Functions

Merging Panoramic Images (PhotoStitch)

You can merge a series of overlapping still images into a single, seamless
panorama. PhotoStitch automatically arranges still images recorded with the
camcorder’s Stitch Assist mode in their correct order and orientation, making it
easy to merge them. Please refer to the Camcorder Instruction Manual to learn
how to record in Stitch Assist mode.

The following instruction explains how to merge still images recorded in Stitch
Assist mode with the camcorder.

’0\ Still images recorded in Stitch Assist mode with Wide-converter or Tele-
\X¥J converter attached cannot be merged correctly.

1 Select still images shot in Stitch Assist mode.
To use PhotoStitch, images need to be shot in Stitch Assist mode. To download
images, please refer to Downloading Still Images (ZoomBrowser EX) ([1] 27).

#7 ZoomBrowser BX - C:\Documents and Settings\Canon\My Documentsi?00x_01_15\STITCH_4796

File Edit Wiew Tools Internet Help

[ Tasks @ ] |E Wigw Image Properties ,rjP Slide Show {a Search ﬁ Delete 'IE_}xj Rotate
- f T n
@ Acquire & Camera Settings ] Zoom Mods | Scrol bode L Freview Mode_ - - —

STITCH_ 4798 4+ FEHY0 - @‘3{ & ; T

|
|
|
|
= L
1

| Favvorite Folders | Al Folders |

(= {} Desktop
=) My Documen ks
=3 200%_01_15
) STITCH_4796
My Music |
i My Pictures
[c] a My Computer

2! Search Results

et ]

Add to Favorites ]

Selected Ihems: 4
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2 Click [Edit].

£ ZoomBrowser EX - C:\Documents and SettingsiCanonihy Documentsi200%_01_158TITCH_4796 |Z||E||Z|

File Edit Wew Tools Internet Help

[ Tasks

W Acquire & Camera Settings

} View Image Froperties @S\ide Show @ Search ﬁ Delete @ Rotate
} STITCH_ 4796 < 4t -0 ([ h& G )| 5 [ | Show | Allmages z
@ Wiew & Clagsify J
—_—
TJ

Zoom Mode | Scroll Mode | Preview hode|

\@ Edit
e
@ P |
@ Internet ]

3 Click [Stitch Photos].
PhotoStitch starts.

&7 ZoomBrowser, EX - C:\Documents and SettingsiCanoniMy Documentsi200X_01_15iSTITCH 4796
File Edit Wew Toaols Internet Help

[ Tasks a] Wiew Image Propetties @S\ide Shiaw @ Search % Delete i‘" Rotate
I n
@ Acquire & Camera Settings Zoom Mode | Scroll Mode ‘I Preview Mude|

STITCH 4736 < 4+ -0- IE\Q s o |l | Show | Alllmsges 7
@ Wiew & Classify

[@ Edit
LEd\l Image

| Stitch Phatos

Fd\l Movie

(===

!
_.l_

4 Arrange the order of the still images and click [2. Merge].

Operational instructions are displayed in the upper section of the window.

Merge Images Shot in Stitch Assist Mode
Chek 12 w«w o Mg T Mager.
Fex erages sl axt o J600 oo uancnin, eheh [nangs]
ssect [ 360 Disgraes] and e chck [2 Merge]

STA_DSTAIPG ST0_05T3PG STC_0S80.JPG STD_0581.0°G

oo of T 4 ST Trim Cokix
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5 Click [Start].

PEE
Fio Edt View Morgn Help

1 Merge Images
i Cheke [Stat] by beagen mesgng.

T Selecton el fvngamert | 2 Mugn |

STA_DSTAIPG STB_0STAIPG STC_DSMLIPG STD_0581.0°G

oo, o s 4 Parwi (scmry, o5, Fual Linigth : s s - Crn Sk

6 Select [3. Save] and then click [Save].
» Select the destination folder, input the file name and click [Save].
* In the View the Saved Image? window, click [Yes]. The Viewer window opens
and displays the merged image.
* To exit PhotoStitch, from the [File] menu, select [Exit].

L' pratostitch

Save Image

Chek [Save] 1 128 the merged mage

To snge o cllerert e, setums ba |1, Sedection and Anargermon]
ek [Chaas] v oo [ Chat ]

I S : PRbATET

@ O You can record the surroundings in 360 degrees, and stitch them together

= later to form a 360-degrees cylinder. (In [1. Selection and Arrangement],
select [Arrange] and [360 Degrees].) By saving this stitched image in
QuickTime VR type, you can then get a virtual view of the surroundings by
manipulating the mouse. For this, you need to have QuickTime installed on
your computer. Ifitis not already installed, install it from the DIGITAL VIDEO
SOLUTION DISK. Place the disc in the CD-ROM drive and click QuickTime
[Install] in the installer panel.

O Please refer to the PhotoStitch Help menu for more details.
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Attaching Still Images to E-mail Messages

You can attach selected still images to an E-mail message.

70\ To use this function, the e-mail software must be enabled as MAPI client. For
\&¥] details, refer to the instruction manual of the e-mail software.

1 Click [Internet] in the Main Window.

&7 ZoomBrowser, EX - C:ADocuments and SettingsiCanonMy Documents
File Edit Wew Toaols Internet Help

| [ Tasks Q ] [ I ) @S\ide Shitas {Q Search
@ Annuire & Camera Settings ] Zoon i ode et e, 2

@ . My Documents € Q Q &2 0 b |_B‘_‘@§ J—-—-f"" Show | Al lmages |
i Wiew & Classify [

B

|
|
l@ Export ] . I. _,’ 4

¥ 200%_01_15 My Music

File Edit Wiew Tools Internet Help

[ Tasks [2)) . @ Siide Show @ search || m o -
@ Acquire & Camera Seffings ]
@ View & Classiy ]
l@ Edi ]
e |
@ |
e 7

|

| Zoom Mode | Serol .Mode_ Preview Mode 5

My Documents € m -0 - @@ ™ Jr—-""‘ Shaow ri&ihmagT |

3 200%_01_1577

| Emal Images
D

elED

3 Select the still images you wish to send and click [Change
Image Size].

&7 ZoomBrowser, EX - C:ADocuments and SettingsdCanon'\My Documents

File Edit Wew Tools Internet Help

Zoom Mode | Scroll Mode | Preview Mode| o _ L
My Documents L 4| -R‘ -0 - |_§_‘&{ J,-——""‘ Shaw | All lmages vi

e
|

7 %) 200%_01_15 My Music

3 Sendor Save

[ - o ]

[ 3 Fieturn to Main Meru ] H IMG_D103.PG  IMG_0104.0FG
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4 Select image size and quality, and click [Send or Save].
If you wish to send the still image without changes, select [Send images
unchanged]. Normally select [Resize and compress images into JPEG type].
- [Long side/Short side]: Selects the long or short side and sets the image size
in numbers.
- [Quality]: The lower the quality, the coarser becomes the still image and
smaller the file size.
- Pressing [Calculate] displays the file size after the compression as [Modified
File Size].
- You can check the compressed still image by pressing [Preview Images].

&7 ZoomBrowser EX - C:ADocuments and SettingsACanoniby Documents

File Edit Wiew Tools Internst Help

{‘@J Email Images STEP 2: Change the | quality Help

f Image Settings “You may wantto reduce the size \

Sl h d andfor quality of the photos to a
“ S el ek total file size of less than 300 KB
© Resize and compress images into JPEG type This insures that people can

receive your email.

l 1. Select Images

L Change Image Size

| 3 SendaorSave

F Finish

© Laong side

ly \|
[ Y/ —

Decrease the file size of the
C exponed photos by reducing
I;l I pixels the dimensions. ZoomBrowser
EX maintains the phota's aspect

et ratio during resizing
==
Ilgl | pixels
le—l
Quality: Highest
3 Retum to Main Menu
“ou can alzo reduce the quality
Original File Size: 828 KB ofthe photo. The image may not
Modified File Sizo 0.0 bytes el look as sharp, but the file size

will be smaller

1) Whenthe image size is large, the images may not be sent praperly by
your email program. A total size of 300KB is recommended
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Select to send still images by e-mail or to save the still
images in a folder and click [Finish].

* If you selected [Create a new email], your e-mail software starts and the
selected still images appear as an attachment in the message window. Input
address, subject and your comments and send the message. E-mail software

not supporting MAPI does not start automatically. In this case, select [Save the
images in a folder...].

* If you select [Save the images in a folder...], click [Browse] and select the
destination folder. Start your e-mail software and attach the saved still image

to a message.

=1 ZoomBrowser E% - C:\Documents and Settings\Canoniy Documents

File Edit View Tools Internst Help

'{‘@- Email Images

l 1. Select Images l

l 2 ChangeImags Size

L Send or Save J

I Retum to Main Menu

Help

Email Settings If your email program supports

WMAPI you can aftach the phatos

@ Creste a new email directly fram ZoomBrowser EX

(1) This option is only available if you use an email program that

supports MAPL e.g. Microsoft Outlonk Express Gl B EEEHE S

photos in afolder, startyour
email program. and then attach
() Save the images in & folder to send through an email program thet does the photos to & new email.

not support MAP]

Then:

1. Startyour preferred email program.
2. Aftach the images to an email as normal and send.
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Running a Slide Show

You can view selected still images in a slide show. Movies cannot be selected for
a slide show.

1 Click [View & Classify] in the Main Window.

You can also view a slide show by clicking [Slide Show] on Application Tool Bar.
Please skip forward to step 4.

T T

&1 ZoomBrowsen B4 - C:\Documents and SettingsiCanoniMy Documents

Fil= Edit View Tools Internet Help

I T e -
[ Tasks @ ] rop l @ Slide Show | @ Search F =
@ e J ZoomMode |Serol Mode | PreviewMose|

ty Documents - + ::ﬁ -0 - |1|'§& J,-——""‘ Shiw | AllImages v

}ﬁ Wiews & Classity

r@ £t 7 3 200%_01_15 My Musio
|
|

|J

=
&
\ Intemet

MG_0101.JRG  IMG_0102.0PG
| = L= |

2 Click [View as a Slide Show].

1 ZoomBrowser, EX. - C:ADocuments and SettingsiCanoniMy Documents

File Edit Wiew Tools Internet Help

[ Tasks 0] () e show @ search gifl -t
@ o e ] ZoomMode [Soolbode | Previewbtode| ..
= My Documents " > 40 -0 - C\ M Show | Al Images v
Lrﬁ-a;_f Wiew & Clazsify J
|7 - N 3} 200%_01 Lsic
| “iew as a Slide Show |
D 1 ._
A |
Rename Multiple Files 7 i )
l Classify into Folder } .
Search ] : " E

Select Images

Zoom Mode | Sl Made | Preview Mode|

iy Ciocuments + 3 j} -0 - |K“§Q J,—-—-—""‘ Shaow | Al Images v|

i ¥ 200%_01_15

—

[ 2 Setup Slide Shaw |
D ~

3 Start Shide Show F

Bty M usic:

[ ‘3 Return to Main Menu ] ’H
7
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4 Select the slide show settings.

* [Image Size]: Select the size of the still images.

* [Image Information]: Select to show image information such as file name or

title.

* [Advance to Next Slide]: Select to advance manually or automatically. When ﬂ
you select “Every 3 second(s)”, you can select the interval in the control below
(from 1 to 120 seconds).

* [Loop]: Select to stop the slide show after the last image or to continuously run
it in a loop.

* [Transitions]: Select the transition effect to be used when moving from one
slide to another. When you click an effect, you can check the effect in the
preview window.

#7 ZoomBrowser EX - C:\Documents and Settings\Canoniiy Documents

File Edit Wiew Tools Internet Help

ﬁ Vig de Show a] Help

‘ '
‘ 1. SelectImages ‘| f Slide Show Settings ’
Transitions:
TN OEEE
] 3 Stett Slide Show || = ==l
| RIE I
|
| ||
| Image Size: O Artual Size E“El
@ BestFit
|
1[4 Retum to Main Meru | | ot Ity iied
e owee . AR
| @ Show Information
| cau EIEIE
Advance to Next Slide: @& On clicking the left mouse button
O Every 3 second(s)
-_— @ o
_/\ 1\ J
Y |

B Click [Start Slide Show].

Click in the lower right corner to end the slide show.
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Adding Sound to a Still Image

* You can add a sound to an image. The sound file needs to be in WAVE type
(extension “.wav”) or in MIDI type (extension “.mid” or “.midi”).
* The sound cannot be played back on the camcorder.

1 In the Main Window, select an image and select [Add/
Remove Sound] from the [Edit] menu.

2 Click [Add].

(8 Views Tools  Internet  Help

Copy Zhrl+C
Copy ko Falder. ..
Move to Folder., .
Select all Chrl+a
Clear Selection Chrl+R

Rotate Image...
Rotate According ko Rotation Information

Edit Image. ..
Manage My Camera. ..

&7 Sound

Currently Selected Sound File:

[ ok, J [ Cancel

3 Select the sound file and click [Open].

4 click [OK].

» The sound file will be copied to the same folder as the image.
 To play back the sound, select an image with a sound icon and select [Play

Sound] from the [Edit] menu.

o To remove sound from an image, select [Remove] on the Sound window in
step 2. '}, disappears and the copied sound file will be deleted.
O The [Play Sound] window appears and plays back the sound.
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Reviewing and Changing the Owner Name of the

Camcorder
You can change and confirm the owner name of the camcorder. ﬂ

1 Connect the camcorder to the computer (11 25).

2 Select [Canon CameraWindow] and click [OK].

Canon + 4 +4 %

Camera connected
Select the program to launch for thiz action:

Cation Carmeratsindow
Downloads Images From Canon Camera

w2 Microzoft Scanner and Cammera “izard
Dowwnload pictures from a camera or scanner

[ &shways uze this program For thiz action

( Cancel

3 Click the [Set to Camera] tab and click [Confirms/changes
camera settings].

# CameraWindow - Canon 3k o4 ok

f‘Acquirelmages Print | | Setto Camera | §3emote shooting

| i

Set My Camera

Confirmsfchanges camera settings

&

il

4= Uploads images to the camera

Diigplays thiz screen when the camera is connected

Freferences...
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4 Enter the camcorder’s owner name and click [OK].

£ Camera Settings

Camera Model: Canon %% % %%

Firmware Yersion: 1.0.0.0

Dwner's Name:
Input a camcorder owner name = Canan |

here (up to 31 characters).
[ Cancel ] l Apply

——
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| Uninstalling the Software

Uninstall the software when you wish to delete it from your computer or when

reinstallation is required to fix corrupted files.

(D

Users of Windows 2000 and Windows XP must first log in as an Administrator

to uninstall the driver and other programs.

Uninstalling ZoomBrowser EX

1 Click the Windows [start] menu and select [All Programs] »
[Canon Utilities] » [ZoomBrowser EX] and [ZoomBrowser

O
4

EX Uninstall].

o When uninstalling CameraWindow, please uninstall it in the following order:
- Numbers or names of cameras displayed in the menu are substituted with

B Internet
7 Internet Explorer

W5 E-mail

g Outlook Express

T Activake Windows

@y Set Program Access and Defaults

W Windows Catalog
4 windows Update

[ Accessories

ia Pla ’j

e Makell [T Games

@ Tor windows $P
!I) Files and Settings Tr.
Wizard

@ ZoomErowser EX

All Programs »

“x” in the following steps.

1) [CameraWindow DSLR x] in the [EOS Digital X] folder
2) [CameraWindow DC_DV x] in the [PowerShot xxxxx-DV X] folder

[7) Startup

a Internet Explarer
W0 ms Explorer

@ Outlook Express
. Remote Assistance
& windows Media Flayer
l‘L indows Messang(_ar

@| Log QFF @| Turn

) Cameraindow  »
I MovieEdit Task  »

3) [CameraWindow MC x] in the [CameraWindow] folder

0O Uninstall all programs in [Canon Utilities] when you have uninstalled

ZoomBrowser EX.

0O PhotoRecord and PhotoStitch can be removed with the same procedure.
o RAW Image Task is used with Canon digital camera. The camcorder does
not support the program, but you can uninstall the program in the same way

as uninstalling the ZoomBrowser EX.
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Uninstalling the TWAIN Driver/WIA Driver

1 Connect the camcorder to the computer ([1125).

2 If a window for selecting an application program or the
Scanners and Cameras Wizard appears, click [Cancel]. If
ZoomBrowser EX started, close it.

3 Click the Windows [Start] menu and select [Settings] and
[Control Panel].

4 Double-click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver/WIA
Driver Uninstallation ([] 98).

B Windows 98/Windows 2000:

1. Delete [Canon Camera] from the [Scanners and Cameras Properties] list.

2. Click [OK] to close the window.

3. Turn the camcorder POWER switch to OFF and remove the USB cable from
the computer.

4. Click the Windows [Start] menu and select [Programs], [Canon Ultilities], [DV
TWAIN Driver x.x] and [TWAIN Driver Uninstall].
A version number appears in place of “x.x”.

Windows Me:

1. Delete the camcorder icon from the [Scanners and Cameras] folder.

2. Click [OK] to close the window.

3. Click the Windows [Start] menu and select [Programs], [Canon Ultilities],
[DV WIA Driver x.x] and [WIA Driver Uninstall].
A version number appears in place of “x.x”.

6 When the Confirm Uninstall window appears, click [OK].

The uninstall process starts.

7 When the Maintenance Complete window appears, click
[Finish].
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| Troubleshooting

Connection

Camcorder is not recognized when connected to the computer.

= Computer does not support the USB interface.
The USB interface is not supported for computer not in compliance with the
following requirements. Acquire the necessary system to use the USB
interface.
Requirements: Built-in USB port on a system pre-installed with Windows
98, Windows Me, Windows 2000, or Windows XP.

= There is no disc or memory card in the camcorder.
Insert a disc or a memory card into the camcorder.

= The camcorder is not set to the correct mode.
Turn the power switch to ON and change the camcorder mode to PLAY by
sliding down the power switch. Move the '® /¢y to 3. Then, select DISC
or CARD in the MEDIA SEL.6a from the SYSTEM SETUP menu.

= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ([1]25) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in
good shape.

= If you are experiencing operational problems, detach the USB cable from
the camcorder and computer and terminate the connection. Restart the
computer and then reconnect the camcorder.

= TWAIN Driver or WIA Driver is not installed properly.
First uninstall the TWAIN/WIA Driver, then reinstall the driver from the
DIGITAL VIDEO SOLUTION DISK (remove the check marks from the other
programs when prompted to select the programs to be installed).

ZoomBrowser EX Operation

Cannot download still images.
= The camcorder is not set to the correct mode.
Turn the power switch to ON and change the camcorder mode to PLAY by
sliding down the power switch. Move the '® /3 to 3. Then, select DISC
or CARD in the MEDIA SEL.©3 from the SYSTEM SETUP menu.
Image files or folders do not appear in ZoomBrowser EX.
= Images or folders shown in ZoomBrowser EX and the actual file contents
may be different when an image file has been moved or copied using
Windows functions or edited with a separate program.
Click the [View] menu and select [Refresh Current Folder].

Driver Installation

Cannot install the TWAIN Driver/WIA Driver correctly.
= Does the system have a built-in USB port and did it come with Windows
98/Windows Me/Windows 2000 preinstalled?

[E]
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= Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ([1]25) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in
good shape.

= Are you using the power adapter to power the camcorder?

= If the problem is not mentioned above, the TWAIN Driver/WIA Driver may
not have been recognized by Windows.
Uninstall and reinstall the driver.

TWAIN Driver/WIA Driver Uninstallation

If you had problems uninstalling the driver, use the following procedures to
remove it.

’0\ The [Inf] folder contains numerous files that are critical to the computer’s
\X¥] operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.

Use the procedures below for the following circumstances too.
- If you do not find [Scanners and Cameras] in the [Control Panel] or
[Printers and Other Hardware].
- If [Canon Camera] or your camcorder model name does not appear in the
[Scanners and Cameras Properties] or [Scanners and Cameras].
- If you connected the camcorder to the computer via the USB cable before
installing the Digital Video Software.

Windows 98/Windows Me
Leave the camcorder connected to the computer.

N
\\>J

1 Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [System] icon.
The [System Properties] dialog appears.

Click the [Device Manager] tab.

0 DN

If [Canon Camera] appears under the [Other Devices] and/or
[Imaging Devices] categories, use the following procedures
to delete it.

1. Select [Canon Camera] and click [Remove].
2.In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

5 Double-click the [My Computer] icon on the desktop

followed by the [C:] drive and the [Windows] and [Inf]
folders.
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If the [Inf] Folder Is Not Visible in the [Windows] Folder

1. Windows 98: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.

3. Windows 98: Set the [Hidden files] section to [Show all files]. IEI
Windows Me: Set the [Hidden files and folders] section to [Show hidden
files and folders].

4. Click [OK].
This makes the [Inf] folder and files in the [Inf] folder visible.

6 Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

~J

In the [Inf] folder, double-click [Other] folder to open it.

8 Find and delete the [Canon.IncCAPxxx.inf] and
[Canon.IncCDVxxx.inf] file.
* The xxx represents numerals.

* If the above file is not contained in the [Other] folder, you do not need to delete
anything.

Windows 2000
Leave the camcorder connected to the computer.

Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [System] icon.

Click the [Hardware] tab.

Click the [Device Manager] button.

AN P WON -

If [Canon Camera] or your camcorder model name appears
under the [Other Devices] and/or [Imaging Devices]
categories, use the following procedures to delete it.
1. Select [Canon Camera] or the name of the camcorder model, right-click
the mouse button and select [Delete].
2.In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.
Remove all copies of [Canon Camera] or your camcorder model name
that appear in the [Other Devices] or [Imaging Devices] categories, or
that appear more than once in one category.
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6 Double-click the [My Computer] icon on the desktop,
followed by the [C:] drive, and the [Winnt] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder

Use the following procedures to show all files and folders.

1. Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.

3.In the [Advanced setting] section, set the [Hidden files and folders]
category to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check
mark.

4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.

T Look for the file for Canon digital camcorders starting with
[Oem™].

* A number such as “0” or “1” will appear in place of the asterisk (*) above. You
will also find another file called [Oem*.pnf], which will have the same number
as the [Oem™.inf] file. The two constitute one set.

* There may be many file sets starting with “Oem”.

* If you double-click an [Oem*.inf] file, the Windows Notepad program will start
and show the file contents. Click each [Oem*inf] file until you find one that
contains “*** Canon Camera Driver Setup File*™*” in its first line. When you
find the correct file, note down its name and close the Notepad window.

8 Delete the [Oem*] file set.

Delete all [Oem*.inf] and [Oem*.pnf] files, taking great care to delete the correct
files.

If You Were Using ZoomBrowser EX Version 2 or 3
(This manual explains version 5.x)

Titles and comments added using a prior version than ZoomBrowser EX
version 4 do not appear in ZoomBrowser EX 4 or higher.
= Titles and comments added using a prior version of ZoomBrowser EX will
not be displayed. Use the following procedure to display them.
1.In Windows Explorer, open the [Program] folder under the folder in which
you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program).
2.Double-click [dbconverter.exe].
3. Select the database you were using until now (C:\Program Files\Canon\
ZoomBrowser EX\Program) and click the [Start] button.
Please note that with ZoomBrowser EX 4 or higher, both titles and
comments appear in the comment list.
Cannot find the image folders saved with a prior version than
ZoomBrowser EX 5.x.
= Image folders saved under the [Program Files] folder (such as [Image
Library One]) cannot be displayed in the Main Window’s Folder Area of
ZoomBrowser EX 4 or higher. Use the following procedure to display
them.
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1.In Windows Explorer, open the [Program Files] folder under the folder in
which you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program\Image Library One).

2. Select the image folder you wish to display and copy the folder to a

different destination. ﬂ
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